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1. Introduction

Thank you for having purchased LAPIS software to set up the UNA domotics system 
manufactured by Terteck Srl, member of the Master Srl Divisione Elettrica group.

UNA is an approach to the science of home and building automation domotics.

The UNA system is made up of one or more EVA boards that include the domotics 
system sensor/actuator functions, and one or more VESTA boards that include the 
high level logic, coordination and integration functions. 

The EVA and VESTA boards are programmed via LAPIS software. According to the 
configuration, LAPIS can reach the VESTA and EVA boards via Ethernet or, when no 
VESTA boards are installed, it can directly connect to the EVA board via CLAVIS, the 
USB to RS485 transformer.

EVA, the UNA domotics system base, is able to control: lighting, blinds, heating, 
weather and climate sensors, outdoor irrigation systems, solenoid valves and pumps, 
timed functions, audio visual signals, analogue video signals, energy savings and 
consumption reading. 
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VESTA, the heart of the UNA logic system, has various interfaces. It controls and 
coordinates EVA boards via 485 bus and uses the Ethernet or wireless connection 
to interface with the user and SIDERA. In the home, the user has access to the 
entire domotics system both via a proprietary Tablet interface and through a general-
purpose Web interface compatible with palmtops or smartphones. 

Outside the home, VESTA communicates via Web with an encrypted and secure 
protocol with SIDERA which, in turn, communicates with the user via a standard web 
interface. 

Not only does SIDERA interface with domotics system clients, but it also interfaces 
with installation technicians to allow them to upload product pricelist and design 
updates on LAPIS, thus controlling both the home while acting as a design office.
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2 Installation kit

The following is required to set up a basic UNA domotics system: 

When installing a more complex domotics system, the following is required to set up 
one or more VESTA boards:

The LAPIS setup software DVD

USB-RS485 CLAVIS adapter

the serial cable with RJ11 connector and 4-pole 
extraction terminal

one or more EVA boards to be set up

any PC or laptop with Microsoft Windows, Mac Os X or 
Linux OS with a USB port.
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the VESTA board to be set up

any PC with Microsoft, Mac Os or Linux OS with 
Ethernet connection to use as an alternative to USB 

connection with the CLAVIS adapter.

a CAT-5 Ethernet cable
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3. System installation 
This section illustrates how to install the LAPIS configuration system and CLAVIS 
adapter drivers. 

3.1 LAPIS installation

LAPIS is easy to install and set up on a computer with Microsoft, Mac or Linux 
operating systems.

Insert the product DVD in the DVD-ROM drive. 

When working in Microsoft environment, the installation procedure will automatically 
launch.  If this is not the case, open the "Windows XP" or "Windows Vista" folder on 
the LAPIS software installation DVD and click on the "Install.exe" file.

When working in MacOSX or Linux environments, in the installation DVD, run the 
"LapisInstallerMac.pkg" file in the "MacOSX" folder or "Lapis.tar.gz" file in the "Linux" 
folder respectively. 

The installation wizard will guide the user through the installation process providing 
information on technical support and licenses. The following paragraphs illustrate the 
CLAVIS transformer installation procedures.  

For further information, please refer to the Quickstart Guide (paragraph 4.1) or 
contact technical support. 
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3.1.1 Microsoft Windows Xp operating system 

Connect the CLAVIS transformer to any USB 
port on your PC or laptop. 
The operating system will automatically detect 
the connected peripheral and search for the 
driver to be used. If asked to search for the driver in Internet, respond no and continue.

In the "New hardware installation 
wizard" window, select "Install 
from a list or specific folder" and 
continue.  To select the driver folder, 
click browse and select the "Driver/
Windows XP" folder on the LAPIS 
software installation DVD. 

Click "next" and, if a protection 
message is displayed, click 
"continue". 
Wait until the driver is successfully 
installed and confirm by clicking 
"end".

At the end of the installation 
procedure, your CLAVIS 
transformer driver will be correctly 
installed and ready for use for 
connections with EVA boards.
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3.1.2 Microsoft Windows Vista operating system

Connect the CLAVIS transformer to any USB port on your PC. 

If connected to the internet, MS 
Windows Vista will automatically install 
and download the transformer driver, 
thus follow the on-screen instructions by 
clicking on "Search and install the driver 
(recommended)".

If not connected to the internet, 
follow the on-screen instructions 
and select "Search and install driver 
(recommended)" and then "Drive not 
available. Show other options". Lastly, 

click "Search for driver software on the computer (expert users)" and select the 
driver in the "Driver/Windows Vista" folder on the installation DVD and wait for the 
procedure to complete.

Note: Windows Vista security settings may display a control window.  In this case, 
click on continue.

3.1.3 Mac OS X operating system

Connect the CLAVIS transformer to any USB port on your PC. 
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On the installation DVD, select the dmg file in the "Driver/MacOSX" folder and follow 
the wizard, rebooting the operating system.

3.1.4 Linux operating system

The most popular Linux versions (like Ubuntu, Suse, Fedora and others) include 
CLAVIS transformer drivers in their operating systems. 

Thus drivers need not be installed.

In the event of transformer operating problems, contact technical support.
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3.2 Eva board connection

To program and test the EVA board, once LAPIS is installed and CLAVIS connected 
to your PC (see paragraph 3.1) connect the serial cable to the transformer and EVA 
board on the connector with AB terminals.

Power the EVA board connecting the power cord to the specific connector. 

To test for correct board operations, make sure the red D45 led is on and the D48 led 
blinks. The two tests check for correct power and correct board operations.
For any EVA board problem, refer to the board manual.
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4 User interface 

The following chapter introduces LAPIS software functions to allow the installation 
technician to set up an EVA or VESTA board in the shortest time possible.



Lapis20

4.1 General user interface

Click on the LAPIS icon to launch the program.  The general program window will 
appear with a vertical menu on the left side of the screen.  Use this menu to:

•	 open the Quickstart guide by clicking on "Quickstart";
•	 open the manual by clicking on "Manual";
•	 contact technical support by clicking on "Support";
•	 update software by clicking on "Update";
•	 exit the program by clicking on "Exit";

Furthermore, the vertical menu lists recently created and edited projects ("Recent 
files") and the EVA and VESTA boards connected to the PC ("Boards found").

The right-hand side of the "Toolbox" includes controls to:

Create a new project

Open an existent project 

Connect a VESTA board    
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When the system is connected to the Internet, all new information on software 
(program updates, product catalogue updates, scenarios, etc.) automatically appears 
to the right of item "Latest news".  Click on the links to open the web page with the 
relevant information.

4.2 Updates

The following paragraph describes how to display and install software and product 
catalogue updates. 

Please note that the entire section assumes that the user is connected to the Internet.

4.2.1 Lapis software update

When an update is released, Lapis software informs the user of the new version 
in the "Latest News" section on the general user interface window. Furthermore, 
a dialogue window appears when the software is launched to request the user's 
authorisation to download and install the new version.

Should the user refuse the update, it can be downloaded and installed later by clicking 
on the link in the "Latest News" section.

4.2.2 Product catalogue update

To update the product catalogue, click on "Update" in the 
main menu when connected to the Internet and enter the 
username and password provided with your Lapis license 
in the dialogue window:

Select the "Remember me" option to save your username 
and password for future use.

You can update the catalogue of products available and support by Lapis in the 
"Catalogue update" folder. 
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The system automatically detects 
new updates.  If available, simply 
click on "Update catalogue" to 
automatically download and install 
them.

Once finished, changes can be 
viewed in the "Catalogue update" 
folder.

Updating the catalogue does not 
mean that all listed devices can be 
used.  Items that cannot be used 
are displayed on a grey background in the catalogue. To enable the new devices, 
open the "Download plug-in" folder and click "Update the list" to check for available 
packages. To install them, click on "Select" and then "Install/update".

4.3 Creating or opening a project

Select "New" or "Open" to open the design interface. The "New" control searches 
for new connected devices by default (EVA, VESTA boards, etc.). To search for new 
devices, click "yes". In all other cases, the design interface is opened. 

The system automatically detects 
connected boards.  When finished, 
an information window is displayed.  
Click "OK" and select the concerned 
board. Complete the procedure 
by clicking on "Import selected 
peripherals".

Note: a link map will be created for 
each selected board (paragraph 
4.4.1).
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4.4 Menus and toolbars

Lapis includes a menu, toolbar and tool palette that provide access to controls, 
settings and most common user modes.
As can be seen in the previous illustration, the default interface includes:

•	 dropdown menus;
•	 shortcut menus;
•	 part catalogue;
•	 main design window;
•	 part property window;
•	 navigator.

The menu is available in the menu bar at the top of the window. A menu option can 
be selected by clicking on the menu item to display the option list and clicking on the 
concerned option or by using the ARROW DOWN key to scroll the list and pressing 
ENTER to select.

The menu provides the following functions:



Lapis24

File

New Create a new project

Open Open an existent project

Open from Remote Open an existent project from 
remote

Save Save a project

Save as Save a project in a new file

Close
Close the project and return to the 
main user interface (paragraph 
4.1).

Recent files Display recently opened projects

Exit Exit the program
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Edit

Cancel Cancel the last operation.

Repeat Repeat the last cancelled 
operation.

Copy Selected Item

Copy the selected item. This 
item will later be pasted by right-
clicking on the desired point and 
selecting "Paste object".

New link panel

Create a new link map (scenario) 
between the EVA board and 
system utilities (peripheral 
devices).

New map panel
Add a new environment map 
(scenario) in image format (JPEG, 
PNG, etc.).

Show grid Show the grid 

Fit to window Fit the scenario to the window

Zoom selection Enlarge a certain scenario 
selection

Zoom in Enlarge a scenario

Zoom out Shrink a scenario
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Tools

Select serial port
Select the serial port to be 
connected to the EVA board or 
other UNA system device

Check updates Update the system (paragraph 
4.2)

Search peripherals Search for devices (paragraph 
4.3)

Update firmware Update device firmware such as 
for an EVA board

Set up network on Vesta Set up network parameters on a 
Vesta board connected to Lapis

Set up GSM/GPRS module Set up the GSM/GPRS module 
connected to Vesta

Save current project on Vesta
Save the current project in the 
connected Vesta board's SD 
memory

Save to Vesta
Save one or more project files on 
the PC hard disk to connected 
Vesta board SD memory

Upload from Vesta
Upload one or more project files 
from the connected Vesta board 
SD memory to the PC

Rule editor (Scenarios) Open the scenario and rule 
creation interface on Vesta
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Window

View
Unlock windows with scenarios, 
view the various open scenarios 
at the top of the design window

Side by side Show scenario windows side by 
side

Cascade Cascade scenario windows

Next Move to the next scenario

Back Move to the previous scenario

Select style Select an application display style

Full screen Full screen application view 

Change catalogue mode

Change product catalogue display 
mode. The default mode displays 
all elements divided in tabs, inputs 
and outputs. The alternative mode 
displays all elements ungrouped 
with a search bar.

Show navigator Display the map navigator 

Show toolbar
Run the toolbar customisation 
tool.  Default toolbar settings are 
shown in bold. 

Window Select catalogue font Change the font type and size 
used in the product catalogue.
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Help

Change language Change the language

Info Program information

Open Manual Display the Lapis manual in pdf 
format

Change license key Edit the Lapis license key

Compared to the menu items listed in the table, the default toolbar lets you: 

start/stop communications with an EVA board

connect to a VESTA board

enable "Linker" mode described in paragraph 6.2

enable "Helper" mode described in paragraph 6.1

display the object property window 

display the created panel list (links, map)

display the window with catalogue items 

display the navigator 
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4.5 Main windows

As mentioned in paragraph 4.3, to facilitate design, Lapis displays a series of default 
windows containing the device catalogue, selected single device properties and the 
environment map.

4.5.1 Design window

The design window is your work plan displaying two design panels (scenarios or 
maps):

•	 link panel: where links between EVA boards and input/output devices are 
displayed;

•	 map panel: environment image where the various devices are displayed where 
they are physically installed. Images can be imported in svg, png and jpeg 
formats.
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4.5.2 Device catalogue

The component catalogue, on your left by default, displays 
the various devices available in the catalogue, grouped in 
three main categories, in a series of dropdown menus:

•	 boards: system control and management devices 
like the EVA board, EVA with consumption control and 
VESTA;

•	 inputs: input devices like switches or sensors;

•	 outputs: devices where control inputs like lights or 
blinds work.

4.5.3 Device properties 

The property window displays the features of 
any item selected in the design window.

Lapis can display input/output device, EVA 
board and DIFRA properties (general settings 
and single board input or output properties).
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4.5.4 Environment map (Navigator)

The navigator displays the complete map associated with one or more link scenarios. 
When the map is zoomed, the enlarged area is displayed in the navigator with a 
transparent red rectangle. Click the zoom rectangle to move the enlargement area, 
holding down the left button while moving the mouse.
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5 Panel and object properties

The following chapter describes main Lapis software component properties to exploit 
full EVA board potential. The user can display information in the property window by 
clicking on the concerned element.

5.1 Link map properties and display

The link scenario features a series of parameters and options:

•	 "panel name": the parameter that identifies the panel with a name can be edited 
by the user;

•	 "size": read-only parameter that indicates the map size in pixels;

•	 “ID”: read-only parameter that associates a univocal sequential number with a 
scenario;
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•	 "show element attractor": option that displays a device positioning bar;

•	 "automatic link mode": option that, when enabled, automatically links devices to 
available EVA inputs/outputs;

•	 "import objects from map": flag the concerned map to associate the link scenario 
to the selected display;

•	 "description": system designer note field.

On the other hand, the link scenario contains the "Panel name", "Size", "ID" and 
"Description" parameters with the same properties indicated for link maps.

5.2 Eva board properties

The EVA board is the main base UNA domotics system control element and is thus 
more complex. 

To simplify use, properties are distributed between descriptive board characteristics, 
"General options" for inputs/outputs (divided in the "Timer" and "General options" 
folders) and configuration controls.

5.2.1 General properties 

All EVA board settings are listed and described below:

•	 "name": the parameter that identifies the board with a name can be edited by 
the user;

•	 "system address": editable parameter that represents the physical board address, 
"Local" will appear if connected directly to the board with Clavis;

•	 "serial number": read-only parameter that indicates the board serial number;
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•	 "serial line": editable parameter 
that represents the Vesta 
serial line where the board is 
connected. When working in 
local, this parameter is read-
only and automatically set to 
0.  Please see the "Designing 
a complete system" chapter for 
further information on Vesta.

•	 "board time and date": this read-
only parameter displays the date 
and time saved in the connected 
EVA board;

•	 "Read board time": control that 
reads the updated date and time 
on the connected EVA board; 

•	 "Update board time": control that 
synchronises EVA board date and 
time with your PC.

•	 "general options" - "Timer" folder: folder that contains the following parameters: 

No bounce delay between start impulse received in input and 
effective output start

Cyclic delay between the various output starts associated with 
the "Cyclic (Video camera)" program

Heating time between valve opening and boiler start

Inversion delay 
Blind wait time between a blind up and down command
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Prolonged pressure time that sets prolonged pressure

Irrigation input start delay associated with the "Irrigation" program

Light time
in sequence

delay between the various output starts associated with 
the "Lights in sequence" program

Light delay 
in sequence

time after which inputs associated with the "Lights in 
sequence" function send the off signal

Home alone time after which the "Home alone" function turns off 
inputs

Blink time Total blinking time for lights associated with the "Deaf" 
function

Alarm exit 
time

total lights on time associated with the "Deaf alarm exit" 
function

RFID reader off time between camera user exit and lights off in the 
controlled environment

Number of blinks number of blinks associated with the "Deaf" function

Number of impulses number of impulses associated with the "Impulse input" 
and "Impulse contact (gate)" function 
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•	 "general options" - "general options" folder: folder that contains the following 
options:

	

Restore previous 
relay status

in the event of blackout, when turning back on, 
the system restores EVA board status

Reversed lights in sequence
parameter associated with the "Lights in 
sequence" function that reverses the lights off 
sequence compared to the lights on sequence

Staggered blind start parameter associated with the "Blind" function 
that staggers blind opening to avoid line overloads

Use single output times for 
sequence 

instead of using the "Cyclic (Video camera)" 
parameter as a global parameter, the "Time" 
parameter set in the various EVA board input 
properties is used

Use single output times for 
irrigation

instead of using the "Irrigation" parameter as a 
global parameter, the "Time" parameter set in the 
various EVA board input properties is used

Lights off 
timer enabled 

turns off relays controlled by the "Lights in 
sequence" function without input impulse 
(enabled by default)

•	 Dawn/dusk: click the specific key to open the 
automatic dawn and dusk management window.  
The "Site management" section lets you select 
the city where the system is installed. Once 
selected, longitude and latitude are displayed.  
Click "Calculate" to update dawn and dusk time to 
the calendar and site. Once set, dawn and dusk 
times can be manually edited by navigating in the 
calendar (selecting the day, month and year) and 
editing the "Dawn" and "Dusk" parameters. The 
"Reset" control returns manually edited times to 
those set for the selected site. 
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Lapis lets you load and save EVA board settings on file using the "Load settings from 
file" and "Save settings to file" controls.  

5.2.2 Input and output pin properties

Each EVA board input or output is characterised by 
parameters:

•	 "Programming": program associated with 
the board input that controls input and output 
behaviour. 

•	 "Time" (simple impulse programming): 
local timers associated with certain functions such 
as "Cyclic (Video camera)" and "Irrigation", to 
enable timers for options "Use single output times 
for sequence" and "Use single output times for 
irrigation" (paragraph 5.2.1);

•	 “Programming (long impulse)”: program 
for prolonged device pressure;
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•	 "Time" (long impulse programming): local timers associated with certain 
functions such as "Cyclic (Video camera)" and "Irrigation", to enable timers for 
options "Use single output times for sequence" and "Use single output times for 
irrigation" (paragraph 5.2.1);

•	 "Timer settings": scheduled actions that can be set on certain days and times of 
the week, two different settings can be managed using the "Timer settings (1)" 
and "Timer settings (2)" folders;

•	 "Associated inputs/outputs"; display inputs and outputs according to the selected 
input and corresponding primary function;

•	 "Associated inputs/outputs (long impulse)"; display inputs and outputs according 
to the selected input and corresponding secondary function ("prolonged 
pressure").

On the other hand, outputs are set by two editable parameters:

•	 "Name": the parameter that identifies the board with a name can be edited by 
the user;

•	 "Emergency": behaviour in the event of emergency which sets the associated 
relay to open or closed in the event of 
emergency.
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5.2.3 Supported input programs 

The various programs and functions supported by device inputs and outputs are 
described below.

       INPUT SUPPORTED PROGRAMS AND FUNCTIONS

1. Wind sensor: the input connected to the sensor controls one or more outputs 
exclusively associated with self-powered blind, shutter and awning descents. When 
there are "n" consecutive impulses within a 10[s] period in input greater than or equal 
to "x" set impulses, the associated relays are excited. "x" can be set in the sensor's 
input property window.

2. Rain sensor: the function, if enabled, prevents the input from managing the 
irrigation function and, vice versa, the irrigation functions tests the rain sensor 
status to decide whether or not it should run. Furthermore, if inputs are set for blind 
management, they can be associated with the sensor and blinds closed in the event 
of rain. 

3. Lights in sequence: the input associated with the function controls two or 
more outputs.  When the input receives an impulse, the associated relays are excited 
in sequence with a "t" delay set between one start and the next according to the 
"Light time in sequence" set in the EVA board property window "Timer" folder. When 
all on, after a time equal to the "Light delay in sequence" setting, all relays associated 
with the functions are turned off according to the same start sequence.

The "t" parameter corresponds to the "Light time in sequence".  However, other non 
global parameters can be used by enabling the "Use single output times for sequence" 
option in the "General options" folder in the EVA board properties window and by 
setting the "Time" parameter for the "Jog" function in the input settings controlled by 
the input with the "Lights in sequence" function. 

By selecting the relevant options in the EVA board properties window "General 
options" folder you can:

•	 enable timed shutdown ("Timed lights off enabled”): after all are turned on and 
after the set time "t", relays turn off one at a time without the input impulse;
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•	 reverse shutdown ("Reverse lights in sequence"): after all are turned on, whether 
turned off using the switch or automated, relays turn off following the start 
sequence in reverse order.

This function can be set on "jog" and "timed with reset" functions but not on "timed 
with restart".

4. General blinds: all blinds are opened with a short impulse and closed with a 
prolonged impulse. Blinds can be staggered by enabling the "Staggered blind start" 
function in the EVA board properties window "General options" folder. 

This function acts on inputs and either single "blind" ascents or descents are specified 
to manage, for example, a blind and close the shutter (shutters work in reverse).
Note: when controlling blinds, awnings or skylights, set the "Blind" parameter in the 
EVA board properties window "Timer" folder.

5. General lighted blinds: an input impulse raises blinds for "t" time, a 
prolonged impulse lowers them for "t" time. The "t" parameter is associated with the 
"Time" item in the EVA board input property window associated with the "General 
lighted blind" function. 

6. Home alone: this function is associated with a certain program in an input 
series. Whenever an input is used to activate a relay, all the other relays controlled 
with this function are disabled after time "t" which corresponds to the "Home alone" 
parameter in the EVA board properties window "Time" folder.

7. DUPLICATE INPUT ON ANOTHER INPUT: works on associated inputs as a 
physical bridge-
This function should be used with outputs, even more than one, not associated with 
other inputs.
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       OUTPUT SUPPORTED PROGRAMS AND FUNCTIONS

1. Jog: the output changes status at each input impulse. The "Jog" program is 
recommended to manage lighting or for some automations that do not include special 
timers. 

This function associates the same input with several outputs (relay).

2. Timed with reset: It behaves the same as the "Jog" function thus the output 
changes status at each input impulse. The additional feature is an automatic shutdown 
after "t" time associated with the "Time" parameter in the EVA board input properties 
window programmed with the function in question. 

This function associates the same input with several outputs (relay).

3. Timed with restart: it behaves the same way as the "Timed with reset" 
program-  However, if the input is pressed before scheduled shutdown, the timer 
starts from zero and counts to the set time. 

This operation can be repeated indefinitely.

This function associates the same input with several outputs (relay).

4. Timed with denied restart: the same as the "Timed with restart" function 
but the input is denied. This function was mainly designed for movement sensors with 
normally closed control.

This function associates the same input with several outputs (relay).

5. Delayed: the relay changes status at input impulse and after set time "t".  The 
relay changes status again at the next impulse. If the button is pressed within time 
"t", time "t" count starts from zero. 

The "t" parameter is associated with the "Time" item in the EVA board input property 
window associated with the  function in question. 

This function associates the same input with several outputs (relay).
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6. Closet: the relay is excited when the door is opened (input open) and turned off 
when closed (input closed. If the door remains open for more than time "t", the relay 
turns off.

This function associates the same input with several outputs (relay).

7. All on: the selected relays turn on at an input impulse.
This function effects outputs and does not take the functions associated with the 
single relays into account.
Consequently, if all board outputs are on, inputs, even timed, will never be turned off 
automatically.

This function associates the same input with several outputs (relay).

8. All off: the selected relays will be turned off at input impulse. Behaviour is the 
same as with the "All on" function.

This function associates the same input with several outputs (relay).

9. Impulse contact (gate): after "n" impulses set in input, the associated relay 
is excited for a short period of time. The interval between one impulse and the next 
must be between about 3s. If this time is exceeded, the timer starts from zero. 

The function cannot be overlapped. The "Impulse contact" program is used to open 
electrical gates or doors. With "n" impulses, the door opens because the relay is 
excited for 1[s].

The "n" parameter is set by the "Number of Impulses" in the EVA board properties 
window "Timer" folder.

This function associates the same input with several outputs (relay).

10. IMPULSE INPUT: after "n" impulses associated with the global "number 
of impulses" parameter in the EVA board properties window "Timer" folder, the 
associated relay is excited until "n" new impulses are received in input.
The interval between one impulse and the next must be between about 3[s].  If this 
time is exceeded, the impulse timer is reset. 
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This function associates the same input with several outputs (relay).

11. CYCLIC (Video cameras): this function is used to associate a single output 
to each input and is significant if at least two inputs, and thus two relays, are used.

Once the function is set, the first relay turns on for set time "t". At the end of this time 
it will turn off and the next one will turn on. 
The "t" parameter is associated with the "Cyclic (Video camera)" setting in the EVA 
board properties window "Timer" folder. The "Use single output times for sequence" 
setting in the EVA board properties window "General options" folder lets you use the 
"Time" parameter set in the properties of other EVA board inputs that manage relays 
with the "Cyclic (Video camera)" function.

12. Room presence contact: the input enables the use or one or more outputs. 
When the function input is closed, the associated relays are enabled.
When the contact opens, the excited relays are turned off after "t" timed associated 
with the "Wait time" variable in the EVA board properties window "Timer" folder.

13. Enable room contact (courtesy light): The associated input controls 
one or more outputs. Furthermore, it is connected to a badge, smartcard or rfid reader. 
The reader generates an impulse on the associated input, exciting the relay for "t" 
seconds associated with the "Time" parameter set in the EVA board input properties.

14. Entrance door: input associated with the door open control.

15. Deaf : The associated input controls one or more outputs.
When the input receives an impulse, the connected relays blink at a set interval and 
for a number of cycles associated with parameters "Number of deaf blinks" and "Deaf 
blinking time" in the EVA board properties window "Timer" folder respectively.

16. Deaf alarm output: The associated input controls one or more outputs.  
When the input receives an impulse, the connected relays turn on for time "t" 
associated with parameter "Deaf output time" in the EVA board properties window 
"Timer" folder.
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17. Blind up/down: each up/down effects an output for time "t" associated with 
the "Time" parameter in the EVA board input properties window programmed with the 
function in question.
If the blind is already rising, a down command interrupts the ascent and, after time 
"t1", enables descent.
The "t1" parameter is associated with the "Blind reverse  display" setting in the EVA 
board properties window "Timer" folder. 

Each ascent/descent is only tied to one blind. Two blinds cannot be associated with 
the same button with this function.

18. Irrigation on/off: this is a cyclical function that effects all irrigation valves 
connected to inputs set with this function. Furthermore, the water pump is turned on 
if specified. 

The single irrigation valves are not specified since the board automatically finds all 
valves. The pump output is optional since not always needed.
If installed, it is associated with an input using the "Solenoid valve control" function. 

Once the irrigation cycle has started, it can be interrupted with another input. 
Otherwise the board stops the irrigation cycle, disables all valves and, if installed, 
the pump. 

Irrigation time for single valves can be set singularly or the same for all peripherals. 
The global parameter is associated with the "Irrigation" setting in the EVA board 
properties window "Timer" folder.
The "Use single output times for irrigation" setting in the EVA board properties window 
"General options" folder lets you use the "Timer" parameter set in the properties of 
other EVA board inputs that manage relays with the "Cyclic (Video camera)" function.

The RAIN sensor prevents irrigation from starting if it is raining and turns off irrigation 
when it starts to rain while irrigation is running. 

19. Irrigation test: this function sets the single valves as input and output.This 
function lets you work on a single valve to test it or, to only irrigate the selected zone 
without having to start the entire irrigation cycle for time "t" (set in the same way as 
function 17).
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20. Boiler control: sets the boiler output. The associated input is also a general 
heating control. If open, heating is running.

Only one boiler can be managed for each EVA board.

21. Solenoid valve control: the valve is an input associated with an output. 
A thermostat normally requires a temperature increase thus the set temperature is 
higher than the room temperature and closes an output that usually goes to the boiler.
The thermostat is connected to a "valve" input which, if closed, activates the specified 
output that turns on a fan-coil or radiator solenoid valve and boiler output. 

22. Dimmed: function that replicates an input on an output.

23. Sewage water management (first and second level): as known, 
the sewage water pump empties waste water wells. This pump is managed with to 
inputs associated with floating sensors. 
An output associated with the drain pump can be set for each input. Level 1 (input 1) 
drains water for "x" seconds until the correct input status is restored. 

Level 2 drains for "x" seconds regardless of the input level. If water is not drained 
within "x" seconds, it may mean that the floater is broken, continuously activating the 
pump. The "x" parameter is associated with the "Time" parameter in the EVA board 
input property window associated with the  function in question.

24. BRIGHTNESS SENSOR: function that controls one or more outputs.
Several twilight sensors cannot be associated with the same board. This function 
acts as a switch that is enabled if a certain brightness limit is exceeded. 

This function acts in two ways:

•	 normally open: this option refers to the type of sensor connected to 
the EVA board. When the sensor is closed, the relays are excited. 
This function lets relays turn off singularly using the associated control. If the 
sensor input is open, the relays are closed and status cannot be changed using 
the associated controls;
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•	 restricted: the sensor enables the outputs it is connected to through the input 
meaning the functions associated with the input are only enabled if the sensor 
switches.

25. Lights in sequence (1 input): works like the the "Lights in sequence" 
function. In this case, a single input controls the "n" connected relays and the 
sequence is in ascending order according to the relay number.

26. REVERSED IMPULSE: once the board is programmed, the relay connected to 
the input with "reversed impulse" function will remain on until the input is closed 
(switch pressed).
When the input opens, the relay closes.

27. ROTATING OUTPUTS: each input impulse corresponds to a sequential start 
of connected relays in ascending order. The function permits a single relay to be 
enabled. A new impulse is needed to disable the last relay.   

5.3 EVA PWM board properties

The EVA PWM board hosts all the previously described EVA functions and measures 
the power absorbed by its relays and manages loads as described below.

5.3.1 General properties

Most general properties are the same as EVA ones.
For this reason, please see paragraph 5.2.1.  Specific EVA PWM functions are listed 
below:

•	 "Show consumption graph": control that opens a window with the consumption 
graph which tracks power values measured for each relay and the total value 
(with a darker green line). Click on the elements in the legend on the right to 
show/hide one or more parts. The axis scales can be edited using a trackball 
(horizontal time axis) or using the "+/-" keys (vertical power axis). To return to the 
initial scale, simply press the "Realign" button.
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•	 "Load management": controls that opens the window where you can manage 
loads.  For a detailed description, see paragraph 5.3.2.
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5.3.2 Load management

This feature is an added value for EVA PWM. In fact, it lets you program output 
shutdown when the measured power exceeds the set limit. 
EVA POWER can be set using the previous two windows: This interface is divided in 
two parts:

•	 "Global parameters": folder that contains the following parameters: 

Delay time delay between reading an exceeded limit and output 
shutdown start.

Restore time time after which an output can be restore if the "R" 
button is pressed (See configurations).

Relay reading
if the output is selected, this means that the current 
reading only returns a value when the relay is on.
We recommend you always keep this option enabled.

•	 "Configurations": folder that contains the following parameters: 

Name Name of the configuration.
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Mode

•	 "No function": the current function remains saved but 
is not enabled.

•	 "Time": the current function is enabled during the 
time interval set in "Start/stop time".

•	 "Day": the current function is enabled from dawn to 
dusk using the Dawn/Dusk table saved on the board.

•	 "Night": the current function is enabled from dusk to 
dawn using the Dawn/Dusk table saved on the board.

Maximum (W) Maximum tolerated consumption value (in Watt).

Input function Indicates the control function input. The associated input, 
if set as a PWM function, is managed accordingly.

Enable-disable 
days The current function is only enabled on the selected days.

Start-stop time
Set the time interval in which the function is enabled. 
They only work in time mode. If the start time coincides 
with the stop time, the entire day is considered valid.

Relay management

The following controls are included for each output:
•	 Vertical selector: lets you select the priority value for 

the output, from 0 to 9.  If the limit value is exceeded, 
outputs are turned off in reverse priority order. If 
two outputs have the same priority, the one with the 
higher load is turned off first.

•	 "Socket" button: if selected, output shutdown is 
prevented, disabling the priority selector.

•	 "Cross" button: if selected, the output is excluded 
from total consumption calculations. It can only be 
selected after selecting the "socket" button.

•	 "R" button: if selected, the output can only be 
restarted after the restore time specified in the general 
parameters.  Otherwise it is immediately restorable.
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Please note that each EVA PWM board can save up to 12 load management 
configurations that can be used simultaneously.

5.3.3 Input and output pin properties

EVA PWM inputs and outputs are the exact same as EVA ones concerning editable 
parameters.
However, outputs also include the power graph, average consumption values and 
real-time consumption measured by the board.

5.4 FLUXA board properties

The Fluxa board is an electronic switch that manages ballast type fluorescent light 
dimming. 
The board has 8 inputs, 4 relays, 4 dimmer outputs on 0-10 Volt protocol and four 
reading points for brightness sensors.
Basic functions, like programming restore and delivery and serial number settings, 
are the same as those described for the EVA board. Please see EVA documentation 
for further information.
The differences between EVA and FLUXA are described below.

To manage lighting with the Fluxa board, specify the type of object to be managed. In 
fact, in addition to classic lighting functions (such as, for example, the jog function), 
Fluxa has specific functions to manage dimming that requires the use of "ballast" 
type dimmer light bulbs.
When you want to associate a light bulb with dimming, associate the relay to be set 
with one of the "dimmable" objects in the catalogue.

The following illustration shows an example of dimmer light settings, associated with 
relay 1, and a normal light point: note how the first is connected to the board through 
two connections.
One of the connections represents the physical connection between the first Fluxa 
relay and light bulb power while the other, associated with the green pin, indicates the 
connections (with 0-10 V type protocol) for dimmer control.
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5.4.1 General properties

Most general properties are the same as EVA.  For this reason, please see paragraph 
5.2.1.  Specific FLUXA functions exclusively concerning dimming and are thus found 
in the board properties input/output "General options (divided in the "Timer" and 
"General options" folders).

The various parameters found in the different folders are described below:

•	 "general options" - "Timer" folder: folder that contains the following parameters: 

No bounce delay between start impulse received in input and 
effective output start

Prolonged pressure time that sets prolonged pressure

Ramp duration time that sets the length of the input signal ramp

•	 "general options" - "general options" folder: folder that contains the following 
parameters: 

Restore previous 
relay status

in the event of blackout, when turning back on, the 
system restores Fluxa board status
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5.4.2 Dimmer management

Dimming is managed using the Fluxa board green pin properties.
Select these elements in the properties window to display the various dimmer settings.
Specifically, settings concern:

•	 "Ramp mode": indicates the type of function to be 
used for dimming. Available modes include "Rising 
only", "Descending only" and "Continuous" which 
includes both "Rising" and "Descending" modes.

•	 "End switch mode": indicates if, when the upper 
or lower ramp limit is reached, the dimming value 
stops awaiting the button to be released and 
pressed again.

•	 "Save mode": indicates that the light, in the event of 
blackout, must be initialised to the minimum (0%) or 
maximum (100%) or to the last set value.

•	 "Light type": indicates the type of light connected 
to the dimmer output, whether a neon light (thus a 
ballast type dimmer) or other type of device (these 
devices will be supported by future Lapis releases).

A bar identified by the item "Dimming value" is found at at the top.
When connected with Lapis, this bar can be used to edit the neon dimming value.

5.4.3 Input and output pin properties

FLUXA inputs and outputs are the exact same as EVA ones concerning editable 
parameters.
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5.4.4 Supported input programs

Some Fluxa functions are identical to Eva board functions. 
Specifically, for functions:
• Jog
• Timer with reset (denied or not) and restart
• Delay
• Input=Output
• All on and off
• Duplicate input on another input
• Inhibit inputs
for full descriptions, please see the Eva board section.

A series of specific functions are also included to manage dimmer lights. These 
functions include:

1. Ramp: at each input impulse, the light behaves as if the "Jog" program was set. 
Dimming is managed with prolonged pressure.nPlease see paragraph 5.4.2 for ramp 
modes.
2. Dark light: this function requires the Master light sensor connected to FLUXA. 
Under the set limit, the light turns on to the selected value.
When initial lighting conditions are restored, the light turns off.
To set the light value, set the Sensor set point (a value between 0 and 255) in the 
properties for the input connected to the sensor (yellow triangle on the Fluxa board). 
3. Fixed light:  this function requires the Master light sensor connected to FLUXA. 
By pressing the button, a light point can be turned on or off and automatically set by 
the system to a set light value.
To set the light value, set the Sensor set point (a value between 0 and 255) in the 
properties for the input connected to the sensor (yellow triangle on the Fluxa board). 
4. General dimmer: general functions that works like an "All on", "All off" control 
which is associated with general dimmer settings for all connected lights. 3 fixed 
values are set: one click to set the minimum value, 2 for the medium value and 3 for 
the maximum value.
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5.5 THERMA board properties

The Therma board is a device that lets you manage heat regulation in an Una 
domotics system.
The board has 8 inputs for connections with controls, 4 relays for actuations and 4 
reading points for temperature sensors.
Basic functions, like programming restore and delivery and serial number settings, 
are the same as those described for the EVA board. Please see EVA documentation 
for further information.

The board can be set to two different operating modes. In fact, you can set:
• stand alone mode where the board autonomously manages heat regulation, ideal 
for autonomous rooms such as, for example, hotel rooms
• behaviour managed by a domotics thermostat. To use this mode, which provides 
advanced heat regulation functions, connections must be made to a Vesta board in 
the system.

5.5.1 General properties

Most general properties are the same as EVA.  For this reason, please see paragraph 
5.2.1.  Specific THERMA functions exclusively concerning heat regulation are thus 
found in the board properties input/output "General options" (divided in the "Timer" 
and "General options" folders).

The various parameters found in the different folders are described below:
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•	 "general options" - "Timer" folder: folder that contains the following parameters: 

No bounce delay between start impulse received in input and 
effective output start

Prolonged pressure time that sets prolonged pressure

Sensor update speed time between one temperature sensor reading and 
the next

Boiler timer

time between valve opening and boiler start Heaters 
request heat and the boiler starts after the set 
number of seconds.
Parameter valid in "autonomous" mode.

Maximum deviation

maximum deviation in degrees between "User 
temperature set points" and "System temperature 
set points".
Parameter valid in "autonomous" mode.

•	 "general options" - "general options" folder: folder that contains the following 
parameters: 

Restore previous 
relay status and 
temperature set 
points

in the event of blackout, when turning back on, the 
system restores Therma board status

5.5.2 Temperature reading points

The Therma board has four temperature reading points. Data is read by sensors 
cyclically with an interval set in the section concerning general board options.
Each sensor is represented by a yellow triangle as shown in the illustration.

Available options for each sensor are:
• Temperature set point, set in the Therma board programming phase, indicates the 
set operating temperature
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• Temperature calibration, set in the Therma board programming phase, lets you 
set the deviation between real temperature and the one indicated by the sensor to 
calibrate the latter.
• System temperature set point, set when connected to the Vesta board ("Run" 
mode), TODO
• User temperature set point, set when connected to the Vesta board ("Run" mode), 
TODO

5.5.3 Supported input programs

Therma board programming is similar to Eva board programming.

Available functions supported by inputs and outputs are:
1. Input=Output: Function that replicates an input on an output: when the input 
is closed, the associated output is also closed.  Consequently, it returns to the open 
status when the input is released.
2. Duplicate input on another input: works on associated inputs as a 
physical bridge.  This function should be used with outputs, even more than one, not 
associated with other inputs. 
3. Inhibit inputs: when the input that drives this function is closed, the input 
associated with these can no longer be activated.
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4. Boiler control: specifies boiler output. The associated input is also a general 
heating control. If open, heating is running. 
5. Solenoid valve control: specifies the output of the valve that controls 
heating. If open, heating is running (the boiler control is turned on) and the 
corresponding output is activated. 
6. UNA boiler heat regulation: function that manages the boiler using the 
"UNA thermostat 1 module" or "Virtual thermostat"
7. UNA valve heat regulation: function that manages the valve using the 
"UNA thermostat 1 module" or "Virtual thermostat"
8. Season: used to set seasonal operations for Therma stand alone programming, 
it controls board Summer/winter operations.
9. Fan coil: function that controls a multi-speed fan coil. 1 or more outputs are set 
according to the number of fan coil speeds.
Speed increases by one each time the input is pressed. 
The last press turns off the fan coil.
10. VALVE OUTPUT 0-10V: function momentarily not managed.
11. single set point: this function, set on an input, lets you increase or decrease 
the set point temperature of a quantity specified by "Set point step" in input options. 
Temperature increases or decreases are not cumulative.
12. repeatable set point: this function works like the "single set point" function 
with the sole difference that the temperature increases or decreases are applicable 
several times.
13. Initial set point: this function restores the set point value set by the 
configuration.  
14. AUTOMATIC BOILER VALVE: for Therma stand alone programming, the set 
temperature controls the zone valve and, consequently, the boiler valve.
15. AUTOMATIC FAN COIL: for Therma stand alone programming, the function is 
similar to the "Fan coil" control with the difference that the fan coil is turned on and off 
according to the temperature set in Therma.
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5.5.4 Autonomous mode

Autonomous Therma board management is able to independently manage heat 
regulation functions using the integrated temperature reading points. When the 
board is set in this mode, remember that each output is implicitly associated with the 
temperature sensor with the corresponding number: in this case, for example, setting 
an input with the "Initial set point" function, relay 1 will refer to sensor point 1 settings.
The following heat regulation functions can be used with this mode:
• Boiler control
• Solenoid valve control 
• Season
• Fan coil
• Valve output 0-10
• Single set point
• Repeatable set point
• Initial set point
• Automatic boiler valve
• Automatic fan coil

Basic operations are the following: the board controls the selected boiler and zone 
valve activation functions (depending on board programming), keeping temperature 
always superior (or inferior, depending on the season) to the one set in the sensor 
"Temperature set point" field.
To change the desired temperature, the buttons connected to inputs with "Single 
set point" and "Repeatable set point" functions can be used. To return to the set 
temperature, select "Initial set point".

5.5.5 Managed mode with virtual thermostat

When controlling temperature in managed mode, the Therma board 
provides temperature data reading and boiler and heat regulation 
valve actuation functions. Configuration and control is managed via 
the Vesta board: this provides advanced functions such as maximum 
temperature limit, minimum temperature limit and thermostat timer 
management.
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To use a Therma board in managed mode, just import a "Virtual thermostat" type 
element in the board configuration panel and create a connection from a Therma 
sensor point to the thermostat using LINKER mode (see the following illustration for 
an example).
To use Therma board relays to start the boiler and heating control points (typically fan 
coils and solenoid valves), the "Una heat regulation boiler" and "Una heat regulation 
valve" functions associated with board inputs must be used.

Configuration example

The illustration below shows an typical configuration for a Therma board in managed 
mode. In this case, a boiler is connected to the first relay with the "Una heat regulation 
boiler" function, two fan coils are connected to relays 2 and 3 and a solenoid valve 
is connected to relay 4 associated to the board inputs with the "Una heat regulation 
valve" respectively.

In this case, there are three "Virtual thermostat" type elements connected to the 
board: these can be set to each control a fan coil or solenoid valve. Please note 
that the same fan coil/valve cannot be controlled by more than one thermostat while 
boiler start can be controlled by several thermostats.

Once connected to a temperature sensor, a "Virtual thermostat" element is similar 
to the "Una thermostat 1 module" with the sole difference that calibration settings 
are performed by the sensor point on the connected Therma board. Refer to section 
5.8 "Heat regulation management with Thermostat 1 Module" for further details on 
Thermostat module settings.
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As for "Heat regulation management with 
Thermostat 1 Module", please see paragraph 5.9 
for details on Thermostat module settings.

5.6 INGRID board properties

The Ingrid board only has 16 inputs. Thus, it is only useful if connected to at least one 
of the previously described boards to increase the number of inputs in the system.
The options included in the properties window are the same as EVA ones while the 
General Options folder only includes no bounce time regulation on inputs.
Lastly, you can set whether the input is reversed or not in input pins. The selection is 
"No" by default.

5.7 DIFRA properties

DIFRA includes a RFID reader able to open a lock, helpful when creating an access 
control system. It is able to save up to 100 codes, dividing them into two categories: 
Master codes, where other codes can be saved using a specific procedure (see point 
"Difra codes"), and traditional codes, that can only be used to open the connected 
lock.

5.7.1 General properties

Even in this case, please see paragraph 5.2.1 for descriptions of functions shared 
with the EVA board. Specific Difra functions are:



User manual 61

General options
the folder now contains the following parameters: 

Reader mode

•	 Autonomy: the code is validated by Difra. It can be 
saved both with Master badges and via bus.

•	 Bus: the reader sends the code read via bus to 
Vesta which validates it and opens the lock.

•	 Mixed: Difra validates it but codes are only saved 
via bus.

Max repetitions Number of readings made before validating the code.

Max Master Codes Maximum number of Master codes.

Max Bit Read
Maximum number of bits consecutively read by the 
algorithm. We recommend a value between 130 and 
140.

Reading Period Period in microseconds used by the Unique algorithm 
for reading. We recommend: 512.

Centring period Period in microseconds used by the Unique algorithm 
for signal centring. We recommend: 0.

Prolonged Time after which an impulse becomes prolonged.

Cleaning Badges Number of cleaning badges.

Master mode
Indicates the Difra board operating mode.
A Difra board has two operating modes: "Master" mode or "Slave" mode. Difra used 
in "Master" mode lets you associate a badge to a Difra board in "Slave" mode while 
a Difra board used in "Slave" mode is dedicated to validating badges and controlling 
access.
To better understand this function, consider the case in which a hotel has a "Difra" 
access control module in "Slave" mode for each room and a Difra "Master" at the 
front desk. Each room can be associated with one or more badges by simply swiping 
them through the Difra "Master" reader.
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To associate a badge and a "Slave" type Difra using Lapis, simply double-click the 
symbol shown at the centre of the Difra board (shown in the illustration).

 An association progress window will be displayed as shown in the following illustration:

At this point, simply swipe the badge to be associated on the Difra "Master". 
Afterwards, the Difra Code association window, described below, will appear with the 
used badge code. Press "Write" to associate the badge with the Difra "Slave" being 
set.

Difra Codes 

Opens the window where codes saved on the board can be read. To do this, simply 
select the desired code number and press the "Read" button. Press the "Write" button 
to save the code in the indicated board memory position. 

Press the "Code Table" button to view all access enabled badges for the selected 
reader. The results are shown in a table 
and association date and time, badge 
code and badge ID for the selected 
reader are specified. 
To view details on the difra code listed in the 
table and eliminate a single association, 
double-click the corresponding row to 
open the detail window for the selected 
code.  
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To program the Difra board without using a PC, please see the RFID manual. 

Difra events
Press this button to display a table listing the acquisition date, event code and badge 
code for the last recorded events. 

The types of recorded events can be:

•	 Eliminated events: indicates that all events in Difra memory were eliminated
•	 All eliminated badges: indicates that all codes for access badges were eliminated
•	 All eliminated non-master badges: indicates that all codes for client badges were 

eliminated
•	 One eliminated badge: indicates that a badge code was eliminated.
•	 Difra on: indicates that the badge reader was turned on
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•	 Access with master badge: indicates that access was made with an administration 
badge

•	 Admitted access: indicates that access was made with a valid badge
•	 Denied access: indicates that access was attempted with an invalid badge (not 

associated with the reader)
•	 Unknown event: indicates that the reader recorded an event other than those 

listed above. In this case, the code specific to the event type is indicated.

Delete board memory
This lets you delete saved codes. The user can select whether all codes or just non 
Master codes are deleted.

WARNING: if all codes are deleted and then non Master codes are deleted, the board 
cannot be used until all codes are deleted again.

5.7.2 Input and output pin properties

Difra only has two input-output pairs. The first is associated with the courtesy light 
while the second controls locks.
The output pins do not have any editable option while programming and timing can 
be set in the same way as for EVA for input pins for normal or prolonged impulses.

5.8 Input and output device properties

Input and output devices (switch, light, etc.) in the catalogue are the system's simplest 
elements. Parameters for both types that can be viewed and edited in the properties 
window are:

•	 "Name": editable parameter that identifies the device with a name;

•	 "EVA Input/Output nr": editable parameters for the input or output associated with 
the device;
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•	 "Description": system designer note field.

Input devices differ from output ones with the "Actions" field that simulates user 
interaction with the device for pressure or prolonged pressure switch.

5.9 Heat regulation with Thermostat 1 Module

To use Una system heat regulation functions, at least one Vesta board and one Una 
thermostat must be installed.
As with other Una family boards, the user can import a new board into Lapis using 
the element catalogue or using the "Search peripherals" function.

Once imported in Lapis, the thermostat element is displayed as shown in the following 
illustration.
In addition to the usual field that display the associated board serial number, the 
information listed in the following table is displayed.

Temperature Current temperature filtered with hysteresis is displayed

Operating 
mode

Available operating modes are:

TMin: the room temperature is kept over the 
minimum set temperature

TMax: the room temperature is kept under the 
maximum set temperature

Chrono: thermostat timer mode

Off: zone valves and the boiler are kept off.
Zone valve 
status

The green icon indicates that the zone valve is 
running
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Operating 
season

Operating season.
Winter
Summer

When Lapis is connected to the board ("Run" mode), the current mode can be 
changed by clicking the icon with the mouse.

Once the elements to be controlled are associated with an Eva board, the zone 
valves, fan coils and boilers controlled by the thermostat can be set.
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To select the zone valve, right-click the "Una Thermostat" element to be set and 
select "Select zone valve" from the menu: all available solenoid valves and fan coils 
are displayed.  Select one to be associated with the thermostat.
 
A boiler can be associated in the same way, selecting "Select boiler" from the menu. 
Elements can also be associated from the thermostat properties window by pressing 
"Change zones".
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6 EVA board based system design

The following chapter uses the LAPIS software functions introduced in chapter 4 to 
allow the installation technician to design a domotics system in the most intuitive way 
possible.

For this reason, LAPIS provides a series of user friendly interfaces and two modes 
(HELPER and LINKER/SELECTION) to help the user set and connect the various 
system elements. 

For unskilled users, we recommend both options are enabled.

6.1 Helper mode

Once enabled by clicking on the toolbar button, the HELPER mode promotes orderly 
component positioning, suggesting the ideal object position and automatically 
connecting the component, based on its properties, to the first available input or 
output. 
Automatic connection is due to the "Automatic connection mode" function managed 
in the link scenario property window.  This function is enabled by default. For further 
information on this function, please see paragraph 5.1.
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The ideal position is suggested by a box with a blue background when a component 
is dragged from the catalogue to the link panel. 
Otherwise, if a component is dragged to a scenario that contains an environment 
map, no position is suggested since the operator will drop the object in the scenario 
where the device will be physically installed.
At the same time, positioning and connections are automatically made in the link 
panel by default. 

6.2 LINKER and SELECTION mode

LINKER mode lets the user link one or more inputs to one or more outputs according 
to the desired function.

When HELPER mode is enabled, once the input (i.e.: switch object) and output 
(i.e.: light object) are positioned in the scenario or link map, click the toolbar button 
to enable LINKER mode.
At this point, click on the input to display and arrow which, if dragged to the output, 
directly creates a link between the input and output on the EVA board where the 
elements in question are linked. The link must always be made from the control/input 
device (i.e.: switch object) to the output device (i.e.: light object).
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Once the two elements are linked, 
a dropdown menu will appear to 
select the function to be applied to 
the relay that controls the output 
device.
For a switch, you can select 
behaviour with normal pressure 
or with prolonged pressure. For 
simplicity in this phase, select 
"Default connections". For 
further information on applicable 
functions, please see chapter 5 
and specifically paragraph 5.2.

If the operation was successful, 
the link between the elements will 
always be displayed on the link 
map by a line in the image that 
represents the EVA board.
Otherwise this link is not displayed 
in the scenario map when passing 
the cursor over the device in 
question.

To move elements in the map, disable the LINKER function by clicking on the button. 
This switches the system to SELECTION mode.

Note: you can switch from SELECTION to LINKER mode by right-clicking a scenario 
section where no elements are installed and selecting the option displayed in the 
dropdown menu.

6.3 Designing a new system

As already mentioned in chapter 4, the main LAPIS user interface opens when the 
program is launched.
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Click "New" to search for new connected devices (EVA boards, EVA boards with load 
control, VESTA boards).
To search for new devices, click "yes" in the dialogue window. The system 
automatically detects connected boards.  Select those of interest and click "Import 
selected peripherals".

A system can also be designed without connected boards: click "no" in the new 
device search dialogue window and enter a generic EVA board from the "product 
catalogue".
Later, when the board is available and connected to your PC, click "Search peripherals" 
in the tool menu, note the board serial number listed in the description (i.e.: 7ffffd) and 
enter it in the EVA board "Properties Window" "Serial Number". 

6.3.1 Linking a connection map to a display map

The previous control opens the design interface and automatically creates a link 
panel for each EVA board selected in the device search interface.
If device search is not selected, an empty scenario is created by default.

Next, to make the design more intuitive, we suggest you create a display panel by 
clicking on "New map panel" and selecting the project map from the browser. The 
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created map is automatically linked to the last link map created. To edit this link, 
select the link map, click on the map and, in the properties window "Import objects 
from the map" section, flag the map panel for the selected link scenario.

Note: refer to paragraph 5.1 for the description of other map properties.

Once the project is created, the imported map can be replaced without losing design 
data. To do this, open the map panel, right-click the map, select "Change map" from 
the dropdown menu and select the new map from the browser.

6.3.2 Adding and removing devices 

Once the two maps are linked (link and display), select the display scenario and 
enable LINKER and HELPER modes. 

To import input and output devices to be installed in the environment, drag the object 
from the device window to the point in the display map where it will be installed.
The added object can be named and a brief description added by selecting it and 
editing the "Name" and "Description" fields in the properties window respectively.
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Once the device has been added to the display map, the same object is automatically 
added to the link map and, using the LINKER mode, linked to the EVA board.

On the other hand, if an object is imported to the link panel, it will not be automatically 
created in the map panel. Thus, right-click the object to be exported to the map, 
select "Copy element" and right-click the map panel selecting "Paste element". To 
copy all elements, right-click an empty panel region, select "Copy all elements" and, 
in the target panel, right-click and select "Paste elements".

To delete an element, right-click it and select "Delete object". You can also delete all 
objects excluding the EVA board by clicking on an empty panel region and selecting 
"Delete all elements".



Lapis74

6.3.3 Linking and disconnecting Input and Output devices 

After adding the objects to be connected, enable LINKER mode, click on the input 
device and, holding the mouse button down, drag the arrow to the output device to 
be controlled. 

Once the two elements are connected, a dropdown menu appears where you can 
select the function to be applied to the relay that controls the output device for normal 
pressure and prolonged pressure (for objects that support these features). 
To program operations for both modes, repeat the operation and create two links 
between the input and output.
For simplicity in this phase, select "All default links". 
The following paragraph thoroughly describes how to program board behaviour.

Objects can be manually linked by disabling the LINKER mode and opening the link 
map. 
Next, click on the EVA board input linked to the input object and press the CTRL key. 
Click on the output linked to the output device and drag the selection to the input 
property "Linked input/output" box. 
To disconnect the two devices, switch to SELECTION mode in the display map.  Click 
on one of the devices to be disconnected to display the link (described by an arrow).  
Right-click the arrow and select "Remove link" from the dropdown menu. If the object 
is programmed in normal and prolonged pressure mode, repeat the operation to 
remove both links.
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6.3.4 Setting input functions 

Lapis lets you program the behaviour of the various linked devices by implementing 
a series of programs tied to timers. 

When a link is made between an input and output in LINKER mode, a dropdown 
menu displays the functions that can be associated with linked devices.  For further 
information on functions, see paragraph 5.2. 

Once the function is set, open the link panel or map and click on the input device to 
edit it. In the properties window, click on the dropdown menu that lists the name of the 
input linked to the device (i.e.: Eva input 1) and set the program type with the relevant 
timer for normal switch pressure and prolonged pressure.

Furthermore, two different functions can be enabled at set times and days by clicking 
on "Set timers". Lapis provides the following timed functions:

•	 device on/off ("On/Off at a set time");
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•	 device on/off disabling manual controls ("On/off at 
a set time without manual input control");

•	 function start ("Start a function at a set time");

•	 device start at dawn and stop at dusk ("Start at 
dawn and stop at dusk");

•	 device start at dusk and stop at dawn ("Start at 
dusk and stop at dawn");

•	 device start at dawn and stop at dusk disabling 
manual controls ("Start at dawn and stop at dusk 
without manual input control");

•	 device start at dusk and stop at dawn disabling 
manual controls ("Start at dusk and stop at dawn 
without manual input control");

•	 start a function at dawn or dusk ("Start a function at dawn/dusk")

•	 enable an input from dusk to dawn or vice versa ("Enable input from dawn/dusk 
from dusk/dawn")

Board behaviour can also be 
edited by clicking on the EVA 
board input in the link map. 
The same input device property 
dropdown menu options will 
be displayed in the properties 
window. 
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6.3.5 Programming connected EVA board  

Once the system is designed, make sure the EVA board is connected to your PC 
(paragraph 3.2) and click "Change mode" in the toolbar to enable connections.

Click on the EVA board in the link scenario and then click "Load configuration" in the 
properties window. 
The EVA board can also be returned to original settings by clicking "Set default 
configuration" in the Eva board properties window and then click "Load configuration".

6.3.6 Testing the programmed EVA board 

Once the EVA board is programmed, LAPIS lets you test its behaviour. 
In the link or display scenario, click on the input device (i.e.: switch) and on the actions 
available in the properties window (i.e.: "Simulate pressure" or "Simulate prolonged 
pressure"). For a switch (input) - light (output) link, the light should turn on or off and 
the relay associated with the light should trigger when the switch is pressed.
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Lapis also lets you test set timers.  To run this type of test, open the link panel, click 
on the EVA board and select "Test timers" in the properties window.  In the dialogue 
window you can:

•	 view the current time saved on the connected EVA board ("Current date and 
time");

•	 view dawn and dusk times set in the EVA board ("Dawn and dusk");

•	 set a precise time and date ("Set time and date");

•	 accelerate continuous timer test time.

Thus the installation technician can set a certain date and time using the dropdown 
menu in the "Set time and date" section by selecting "Set time and date". 

Alternatively, continuous board behaviour can be tested by click the "Start test" 
key after setting test start/end date and time in the "Test parameter" section, board 
time update frequency ("Update time") and the time increase at each board update 
"Interval"). For example, with reference to the illustration below, click the "Start test" 
key to check board behaviour from midnight on 01/01/2000 to midnight on 12/09/2052 
with a 2 minute time increase every 3 seconds. 
At the end of simulation, click "close".  A dialogue window will ask you to restore the 
EVA board time set before the timers were tested. 
In the event of operating problems, the code sent to the programmed EVA board 
can be viewed by clicking "Debug configuration" in the board properties window. 
The code is divided between the real configuration ("Debug board configuration"), 
time parameters ("Debug timer configuration") and dawn/dusk ("Debug dawn/dusk 
configuration"). We recommend you only use this option for system inspections with 
Master Srl Divisione Elettrica personnel.
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6.4 Updating EVA board firmware

Lapis lets you update slave board firmware: EVA, EVA PWM and all other Master 
products. When Master-de Srl releases new firmware, connect one board to your PC 
at a time and select "Update firmware" in the "Tools" menu.

Select the serial port connected to the EVA board via CLAVIS and click "Open port". 
Next select "Set Boot mode" and enter the board serial number. If the operation is 
successful, the board ID and boot loader version will appear in the status window and 
the green EVA board D59 led will blink faster than in "normal mode". 

To cancel and update firmware, 
click "Update firmware" selecting 
the newly downloaded file from 
the browser. Once the update is 
complete, click "Set normal mode".
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Note: be careful when performing these operations since any errors could damage 
the board.
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7 Designing a complete system

The following chapter describes the most common EVA board programming 
procedures.

7.1 Vesta configuration

The previous chapter accurately described a system design based on a single EVA 
board.
In some situations, however, a single board cannot sufficiently manage all desired 
elements. The Vesta board was specifically designed to permit the simultaneous 
use and interconnection of several "slave" boards (EVA, EVA PWM, Difra, Ingrid) 
within the same domotics system.

7.1.1 Physical board connection

Vesta comes with an Ethernet adapter.  Thus Clavis is no longer required for 
connections.  Simply connect your PC to the same network.
If Vesta is not connected to an Ethernet network, it can be directly connected to your 
PC. First, connect the two Ethernet cards with a crossed network cable. Next, based 
on the operating system, change network settings as indicated below:

Windows XP
1. Open the Control Panel in the Start menu.
2. Select classic display and open "Network connections".
3. Right-click the current local network connection (LAN) and select "Properties".
4. In the "General" section, select "Internet protocol (TCP/IP) and click "Properties" 
to open the properties window.
5. In the General section, click "Use the following IP address" and enter:
	 1. IP Address: an address between 192.168.1.1 and 192.168.1.254.
	 2. Subnet mask: 255.255.255.0.
	 3. Default gateway: not used.
6. Click OK until all previously opened windows are closed.
7. Reboot your computer.
8. Once the PC is running, open Lapis and continue with the next steps.
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Windows Vista

1. Open the Control Panel.
2. Select classic display and open "Network connections centre and sharing".
3. Select "Manage network connections" on the left.
4. Double click "Connect to current local network (LAN)".
5. Click "Properties" and authorise.
6. In the General section, select "Internet protocol version 4 (TCP/IPv4) and click 
Properties to open the properties window.
7. In the General section, click "Use the following IP address" and enter:
	 1. IP Address: an address between 192.168.1.1 and 192.168.1.254.
	 2. Subnet mask: 255.255.255.0.
	 3. Default gateway: not used.
8. Click OK until all previously opened windows are closed.
9. Reboot your computer.
10. Once the PC is running, open Lapis and continue with the next steps.
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7.1.2 Vesta network configuration

To set up the network on Vesta, select "Set up network on Vesta" from the "Tools" 
menu.

The Vesta set-up window appears with the list of boards currently installed in the 
network. The list can be updated by pressing the "Search" button. The list includes 
the name of each board ("Device" column), its network address ("IP" column) and 
information on its operating status ("Infos" column).

Six buttons are found at the top of the window:
• Search
• Set-up
• Update
• Reboot
• Reboot in minimum mode
• Disable Sidera Indoor

The first button lets you update the device list. 
The second button lets you set-up boards. 
The third launches the board software update procedure. 
The fourth button reboots boards. The fifth reboots Vesta in minimum mode, thus 
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launching Vesta without loading any modules so that the board can only dialogue 
with Lapis through the Vesta network setup window. 
The last button lets you disable Sidera Indoor service on the board.  Please not that 
the service will be launched the next time the board is rebooted.
Flag the "Show Visus panels" box at the bottom to enable their search, letting you run 
the following functions:
• send Default setup
• edit icon theme
The first function lets you update the default project on Visus and the second lets you 
edit the icon theme.

To setup a board, select the required board and press "Setup". 

The screen that appears lets you edit the machine name to identify the system from 
here on and set the clock. The clock can be set in three ways, selected by clicking 
the box repeatedly:

Auto Sets the same time as the PC on Vesta.

Manual The user sets the time in the box.

Disabled Time not set.
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The section below lets you edit the board location, specifying the "Region" and "Town".  
This effects the board's time zone and daylight savings time settings. Furthermore, 
time synchronisation via Internet can be enabled or disabled. If this box is flagged, 
the board will periodically connect to a set NTP server.

Network parameters can also be set: enable DHCP service, the machine IP address, 
subnet masks and the gateway IP address. 
The right side of the setup window lists information on board operations:
• Board uptime (running time since last board reboot)
• Application uptime (application running time)
• CPU space used by Vesta software and global
• RAM space used by Vesta software and global
• Hard disk and SD card space used (if installed)

Once all changes are made, click OK to save (the Vesta software on the board will be 
rebooted) or Cancel to return to the previous configuration. 

NOTE: If directly connected to Vesta via cross cable, set an IP address between 
192.168.1.1 – 192.168.1.254 (different from the PC address).
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7.1.3 GPRS module configuration

Vesta comes with a GPRS module to send controls or receive alerts via text message.
To set it up, select "Set up GPRS on Vesta" from the "Tools" menu. The window that 
appears contains the following editable parameters:
•	 System: the Vesta board to be set up
•	 SIM PIN: SIM card PIN code in the module
•	 Authorised input numbers: list of numbers authorised to send controls.
•	 Authorised output numbers: list of controls enabled to receive alerts.

Four operating indicators are displayed next to the current system:
•	 Telephone service provider (in the example: “vodafone IT”)
•	 Signal quality
•	 Device status (online/offline)
•	 SIM PIN status (entered/not entered)

To add a number to one of the two lists, press “+” and enter the name and number in 
the spaces below.
To delete a number, select it from the list and press "-".
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7.1.4 INFRARED control management module configuration

One of Vesta's functions manages signals received from an infrared remote control. 
The set up procedure lets you use various types of devices, recognising the remote 
control signal and saving the selected keys (for further information, see the enclosed 
"Supported Remote Control list").

To set up the infrared control module, select "Set up infrared module" in the Lapis 
"Tools" menu.

The displayed window, illustrated below, contains the following elements:
• System: list of currently running Vesta boards. Select the board to be set up from 
this list.
• Control list: list of controls to be associated with the remote control keys to be set 
up. This list, initially empty, will include the names to be associated with the controls 
to be saved.

You can add elements to the list by clicking the "Add" key on the right. Once clicked, a 
dialogue window is displayed (at the bottom), where you can enter the control name.
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After completing the control list, start recording by pressing the "Start recording" 
button. A dialogue window appears (illustrated at the lower left). 
When confirmed, the window illustrated on the right will appear with instructions on 
how to record.
Answer yes in this case to start the recording phase.
The first recording phase consists in pressing various remote control buttons, holding 
each down for about one second.
For successful recording, each button must be pressed separately for short periods.
As shown in the figure below, an icon, over the "Add" button" informs the user that the 
receiver is correctly acquiring the impulses from the remote control.

This phase ends after a variable number of remote control key presses. 
At the end of the procedure, a dialogue window like the one shown on the lower left 
will appear.
Once the recognition phase has ended, create a link between the items entered in 
the list and the remote control keys. 
To do this, select elements from the list one at a time and press the "Record" key. 
A message will appear to warn you to press the remote control key to be linked. 
Once confirmed, press the remote control key: if successfully linked, a confirmation 
message will be displayed. 
Keys may not be correctly recognised during the recording phase: in this case, a 
message asking you to repeat the link is displayed. 
If the link fails several times consecutively for a single key or for all keys, we 
recommend you check remote control compatibility and repeat the entire recording 
procedure.
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To end key recording, simply press the "End link" key. As can be seen in the illustration 
at the top right, the "Recording successfully completed" message appears in the 
window status bar to confirm operation results.

An additional confirmation can be had on link correctness, as shown in the next 
illustration.
To apply changes to links, send the project file to Vesta.

Once the project is loaded in Vesta, you can check correct remote control key 
recordings by opening the infrared control module set up window. The grey icons to 
the right of the listed elements should briefly turn green when remote controls keys 
are pressed.
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7.1.5 RADIO control management module configuration

The Vesta module lets you record various types of 434 MHz remote controls. 
Nevertheless, correct link operations highly depend on the manufacturer's protocol. 
For further information on supported radio remote control compatibility, see the 
enclosed "Supported Remote Control List" or visit sidera.terteck.it.

Radio remote control set up is the same as infrared remote control set up. 
Therefore, please see that paragraph for a detailed description.
The substantial difference between the two link modes is in the signal recording 
procedure: hold down key to be linked on the radio remote control and then press 
and hold down the "Record" key until successfully recorded.
As with the infrared management module, once the project is loaded in Vesta, you 
can check correct remote control key recordings by opening the radio control module 
set up window. The grey icons to the right of the listed elements should briefly turn 
green when remote controls keys are pressed. 

7.1.6 Sound configuration

The Vesta board can reproduce sounds if connected to speakers. The Vesta can 
reproduce two types of sounds:
•	 recorded sounds (wave type files)
•	 convert text into sound thanks to its voice synthesis capacity (TextToSpeech 

function)

The second type is support thanks to Festival, a software that generates sounds from 
written text.

Both reproduction modes are simultaneously supported by Vesta.
As for the log function, an SD card must be inserted in the Vesta slot where sound 
files and various Festival voices are saved.
Furthermore, a special SD card must be used to use Festival, suitably formatted for 
TextToSpeech support.
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To set up the voice synthesis system and load the sound file on Vesta, select "Manage 
Vesta Sounds" from the "Tools" menu. The sound management window appears:

First select the Vesta to be set up from the "System" dropdown menu. Next start 
loading files to the Vesta board or set up the voice synthesis system.

Press “...” to select the required file (maximum loadable file size is 5MB).  At this 
point, the "Filename" text box background turns red: this means that the file was not 
loaded in Vesta. Name the file to be loaded and press "Upload".
If the file is successfully loaded, the "Filename" text box background turns green. At 
this point, click "OK".
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The loaded file will be displayed in the central list. To add other files, repeat this 
procedure. To delete a file from Vesta, select it in the list and click "Remove". To 
change a loaded file name, select it and click "Edit...", rename the file and click "OK. 

The voice synthesis system is set up using the dropdown menus at the bottom of the 
window.
Use the first to select one of the languages in the SD.  Use the second to select one 
of the items associated with the selected language.
The configuration in the illustration above sets the language to Italian and the voice 
to "pc_diphone".
When finished, click "Save" to apply settings when the configuration is sent.

Please note that voice synthesis performance is significantly inferior and with lower 
priority than recorded file reproduction. This prevents deteriorating Vesta board 
performance and stability.
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7.2 Design steps

Designing a complete system is not any more difficult than that described in the 
previous chapter. Simply follow the steps below:

7.2.1 Creating the project on Lapis

The project can be created after correctly setting up Vesta.
A different link panel must be opened for each board in the system while any number 
of map panels can be entered. There are two ways to import boards:

•	 "Using discovery": select "Search Peripherals" from the "Tools" 
menu. A box that lists system visible from Lapis appears. 
Double-click the desired system (identified by the previously mentioned name). 
The discovery window opens at this point. If this does not automatically open, 
click "Start auto-peripheral search" and wait until the end message is displayed. 
At this point, select the boards to be imported in the project and click "Import". 
The result is the creation of a link panel for each selected element.

•	 "Manually add": select the Edit -> New link panel menu 
(or use the menu bar key) to create an empty panel. 
At this point, drag the desired board from the catalogue to the 
work area and enter its serial number in the properties window. 
There are two ways to connect it to the system: enter the name in the "System 
address" field or click on "Connect to Vesta" in the menu bar and drag the name 
over the board.

In both cases, board programming is the same as programming boards connected 
via CLAVIS without using Vesta.
The following two paragraphs describe the various types of programming to let 
the different boards connected to VESTA interact through scenarios or simple 
interconnections between different boards.

7.2.2 Linking Input/Output devices and different board 
interconnections
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To connect input and output devices on the same board, please see chapter 6.

Board interconnection means creating a direct connection between different board 
inputs. To do this, use the "link lock" (available in the "Vesta logic" section in the 
"Components Catalogue", a special element that connects in the traditional way but 
represents the link in question.
Simply import this lock in the link panel with the board to be controlled and select the 
control input (or condition) by right-clicking on the "Virtual Bridge" icon and selecting 
the event that enables this input from the "Condition Selection" menu.

For example: if you want the control programmed in the EVA board input 2 in my 
project to turn on when the key linked to the Ingrid board input 1 is pressed:
•	 enter the "Virtual Bridge" element in the link panel with the EVA board and link it 

to input 2;
•	 right-click this element and select "Condition Selection", "Ingrid Board", "Ingrid 

Input 1", "Ingrid Input 1 pressed".
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Several conditions can be entered to activate an input. To do this, simply repeat 
the condition selection procedure.
Lastly, click on the "Virtual Bridge" lock. The properties of all set conditions 
appear in the window. As activation conditions, select all actions true or only 
one action true in the dropdown menu.
To delete a condition, click on the red x in the conditions listed in the properties 
window.

7.2.3 Creating scenarios

Scenarios are lists of actions to be taken on system elements that turn on/off when 
all or some user conditions are true. 

I.e.: Scenario 1: If one of the following events is true "X button pressed, Light L off", 
Apply the following actions: "Turn on light Y".
In this scenario, light Y turns on when any one of the two set conditions is true. To 
correctly interpret the meaning of the created scenarios, you must understand that 
scenarios are only evaluated when an event occurs, like a button being pressed or 
a light turned off. 
Therefore the scenario in example 1 can also be expressed as "If button X is pressed 
or if Light L is turned off, turn on Light Y".

I.e.: Scenario 2: If all of the following events are true "X button pressed, Light L off", 
Apply the following actions: "Turn on light Y".
Here too, the scenario is triggered when an event occurs, either the Y button is 
pressed or light L is turned off. 
However, for the action to be run, both conditions must be true meaning that light 
L must be off when the button is pressed, as indicated in the rule. The opposite, 
meaning that Light L turns off and button X was pressed is also valid, even if it makes 
no sense in this specific case since the button has no "on" status, but can only notify 
the on event. In conclusion, example 2 can be expressed as: "If button X is pressed 
while light L is on, light Y turns on".

I.e.: Scenario 3: If all of the following events are true "X button pressed, Light L off", 
Apply the following actions: "Turn on light Y" until one of the follow events occurs: 
"Light Y on".
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The scenario in example three is true at the usual conditions, it turns on the light and 
remains true until light Y turns off. As long as a scenario is on, it can not be turned on 
again. For example:

1. Scenario 3 turned on and off
2. L on, scenario off
3. → the user turns on X → the scenario (off) is turned on “Scenario 3”  → Y is turned 
on
4. → the user turns on X → Scenario 3 can be turned on, but it already is → nothing 
happens
5. → the user turns off Y → Scenario 3 is turned off
6. → the user turns on X → the scenario (off) is turned on “Scenario 3”  → Y is turned 
on
7. ….

Following we will say that a scenario is:
• used, if actually available in the system
• on, if the conditions are true and until conditions to turn it off are true
• enabled, it it can be turned on when conditions are true
Scenario editor
To create new scenarios, use the "Scenario editor" found in the tool menu.

SCENARIO EDITOR
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The scenario editor is divided in three panels. 
The panel on the left shows created scenarios and lets you add new ones using the 
dropdown menu

flag a scenario to use it 

and rename (by double-clicking it) or delete a scenario by clicking the icon

The central panel shows the definition of the scenario currently selected from the 
panel on the left. 
The panel on the right shows the various functions provided by the elements in the 
system which, dragged to the central panel, set scenarios.
The terms listed in the left panel may require free parameters to be specified. They 
can be manually set or, using the the button  

use the value returned by another compatible term, selected in a list similar to the 
panel term list.

For example, this mode can be used to print a received text message on the screen.
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"Main switch" scenarios

"Main switch" scenarios are used to model main switches, or simple rules such as 
"If...Then...". Thus, as soon as turned on when conditions are true, they run the 
indicated actions and turn on to become immediately available to be turned on again 
when conditions are true. Conditions are listed in the green list in the editor:

A scenario without conditions runs its actions immediately when it is enabled. Use the 
dropdown menu to select whether the listed conditions must all be true or if just one 
needs to be true to start actions.  



Lapis100

The second lists the actions to be taken when the indicated conditions are true. "Main 
switch" scenarios are immediately turned off thus they can be immediately turned 
back on when conditions are true. In fact, they are used to quickly model a main 
switch.

Please note that conditions and actions are considered in list order.

By default, scenarios are enabled with the system is launched. Use the checkbox at 
the top of the scenario panel to disable the scenario when the system is launched. 

This can be helpful when building more complex scenarios.

Since activation conditions are often reassessed when a potentially sporadic event 
occurs (such as a light sensor that triggers at dust) scenario actions may be activated 
long after the scenario is enabled even it, logically, the activation conditions are met. 
For this reason you can force scenario activation condition reassessment as soon 
as the scenario is enabled (for example, by default, when the system is launched) 
without waiting for the event to occur, using the checkbox show in the illustration 
below.

This can be considered an additional condition to activation conditions, meaning: "if 
the scenario is enabled and all activation conditions are met, activate the scenario". 

Simple scenarios

Simple scenarios, unlike "main switch" scenarios, explicitly need off conditions to be 
set. Therefore, the simple scenario settings panel is similar to the main switch panel 
except for the off conditions list shown below.
Drag the name of a scenario from the left scenario editor panel to the action list (red) 
to run the actions on the selected scenarios. 
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"Main switch" scenarios provide the following actions:
• on: main switch actions are forced on regardless of the conditions set for that 
scenario
• enable: the scenario, if disabled by default and not yet enabled, is enabled and 
remains so until at least one of the scenarios that enabled it is on. Default scenarios 
are always on.
Simple scenarios only provide on functions. 

Load cut-off scenarios

"Consumption" scenarios adapt rule activation if the total of some values is greater 
than a set value. In this case, a typical load cut-off scenario is the following: "if total 
consumption > 4kW, after 10 seconds, turn off the oven, after 20 seconds, turn off 
the washing machine, etc.". 

If the considered values do not have a unit of measure compatible with the one 
specified for the limit, an alert message will appear.
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7.2.4 Advanced timing with Vesta

Rule conditions and actions have an evaluation time context. Normally the context 
is that of turning on the rule, meaning actions and conditions are immediately 
evaluated. Additionally, the time when conditions and actions are evaluated can be 
set by clicking on the icon. 

A dialogue window will appear where the type of timer can be selected:
1. instantly, referred to the evaluation time or absolute time:
2. recurrent with a set frequency, starting from an absolute time (time or date-time) 
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or from the evaluation.
The timer is applied to the evaluation of the conditions/actions displayed in cascade 
to the timer. 

For example, the illustration shows the light will be turned on at the specified time 
(11/6/2009...) and 10 seconds after turning on.

If the timer precedes all other conditions (and in this case it is highlighted in grey) 
the scenario will be enabled and cause, when elapsed, the following conditions to be 
evaluated.
If the timer is relative, the reference time is the scenario enable time.
If the evaluation of one condition is applied to a recurrent timer, the condition will be 
repeatedly evaluated according to the period set in the timer and return "true" at the 
end of the timer only if "true" at each single evaluation.
The same applies for "false" evaluations immediately after deemed "false" without 
waiting for the timer to elapse.
Recurrent timers referred to actions repeat the action in each interval.
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Please note that each time scenario conditions are re-evaluated (for example, due 
to an element status change) a valid evaluation context is maintained for the entire 
period in which the scenario is enabled. Therefore, several evaluation contexts can 
be on simultaneously with their respective actions to be run. 

For example
• time 0: light on, user turns on “Button” → new context that expires at time 6
• time 2: user turns on “Button” → new context that expires at time 8
• time 6: first context expires → light turns off
• time 7: user turns on light
• time 8: second context expires → light turns off 
Even for actions, execution contexts are turned on which, however, like default 
behaviour, are valid until all timers have expired (even if the scenario is disabled). 
This behaviour can be change using the option:

selecting delayed actions are terminated when the scenario is turned off or disabled.

7.2.5 Notes on scenario actions

Not all actions and conditions available in the editor are directly controllable by the 
system. For example, a simple incandescent light has no direct form of communication 
with the system to notify when turned on or off.
However, knowing the elements' wiring, the light's status can be accessed indirectly 
by reading the status of the EVA board output connected to the light. In the same way, 
a simple switch has no direct communications means with the system to notify, for 
example, being pressed by the user.
Here too, events can be traced by reading the status of the EVA board input to which 
it is connected.

The system best exploits all the wiring information attempting to make each listed 
action/condition available.
If a condition cannot be verified do to lacking connections, the following message will 
be displayed:
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If there are multiple alternatives to check the same condition, the user is asked to 
choose the preferred one:

and this preference will be saved for subsequent occurrences. The implementation 
used for a condition can be checked by moving the cursor over the condition in the 
list.
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Furthermore, all possible options are proposed as flaggable in the term list, automatically 
updated after changing wiring configurations. The current implementation in use, if 
set, is the flagged item:

Unlike conditions, actions are effectively implements when activated in scenarios.

7.2.6 Advanced element management via Vesta (status, 
message, virtual button and switch)

Status element

A "Status Element" is found in the Lapis "Component catalogue" in the Logic section.  
Its graphic representation is the logic status (on/off) of its connected element. If this 
element is in on status, the "Status element" turns green, otherwise it is red.

This element only accepts input connections.
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Message element
The Lapis "Rule Editor" "Element List" contains a "Message" element as shown in 
the illustration whose activation can be linked to a certain condition. Activating the 
message element displays the selected message on Visus.

As shown in the two illustrations, different text descriptions can be linked to this 
element.
In fact, you can add whatever text you want by clicking on the green icon on the right 
and selecting either:
• last received text message content
• last received text message sender
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Virtual key

An element called the "Virtual Key" is found in the Lapis "Component Catalogue" 
"Logic" section.
This element logistically represents a virtual device with a sole output that can be 
linked to any element that has an input port.
The "Virtual Key" does not have any status representing an impulsive type logic 
control.

Virtual switch

A "Virtual switch" is included in the same section as the "Virtual Key". The only 
difference between the two virtual elements is that the first, as the name suggests, 
has two statuses, on and off, which correspond to two different output signals.
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7.2.7 Sending the project to Vesta

Once completing the project on Lapis, click "Play" in the toolbar to send it to Vesta and 
switch to "Run" mode, awaiting delivery. This operation may take several seconds.

WARNING: sending a new project fully overwrites the previous project.

7.2.8 Printing wiring instructions

The printing wiring instructions function provides the user with a printable version 
of the project created in Lapis, organised to permit the simple consultation of the 
relations between the various Una line devices and project elements.
It also lets the user export project documents in PDF (Portable Document Format) 
and ODT formats (OpenDocument Text Document, typical open office format).

To generate the document with wiring instructions, simple open a Lapis project and 
select "Print wiring instructions" from the "Tools" menu. A new window will appear 
with a simple text editor where the generated document is displayed. 
The document can be edited using the provided functions for customisations. 
Text formatting tools (font type and size, bold, script and underlined, colour), 
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paragraph settings (justified, align right, align left or centred), copy and paste and 
undo-redo functions are available.

The generated document consists of a heading with the project name and description 
assigned the first time it was saved or edited using the "Edit project details" tool in the 
File menu. The document creation date is also listed. 
The next part includes all project devices listed in a table: any associated functions 
and links with other system elements are listed for available inputs and outputs on 
each board.
It is important to note that each item in the table is numbered with an univocal number 
called the "Map Code": this identifies the element on the map in the third part of the 
document, indicating the object's physical position in the environment. 
In fact, a different page is printed for each project map which includes the "map 
codes" of the elements listed in the table, as shown in the illustration.
Once the wiring document is generated and edited as pleased, it can be printed by 
selecting "Print" from the "File" menu. 

The printer and print options are requested. For a print preview or to edit page format, 
simply select "Print preview" from the "File" menu.To save the file in odt format, select 
"Save" from the "File" menu and select the name of the file to be saved. Once the file 
is saved, it can be opened and edited using a text editor like OpenOffice.org Writer 
or Microsoft Word (after installing the specific add-in).
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The file can also be saved in pdf format, selecting "Export to PDF" in the "File" menu.

7.2.9 Remote project saving/loading

Vesta supports SD memory connection to save project files for further use on a PC 
other than the one where the file was initially created.
The "Save to Remote" and "Load from remote" functions in the Tools menu display a 
window with a list of known system on the right. Double-click on the name of one of 
them to display the current list of loaded projects. At this point, based on the selected 
function, use the buttons at the bottom to select the file to load or folder where the 
selected project is to be saved to run the function.
The Tools menu also includes a "Save current project in remote" function that provides 
a shortcut to save the current project.

7.4 Vesta database management

To explore the Vesta database, select "Explore Vesta database" in the "Tools" 
menu.

Any tables in the selected Vesta database will be automatically loaded (in this case 
VestaSh).
At this point, the various tables can be explored using the controls at the top right-
hand side of the window.
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The first control is "Order by".  This orders results by table column name in 
ascending or descending order. Flag the box to use this control. The second 
control is "Filter".  It is used to filter results based on a data criteria in the table. For 
example, the following illustration shows a filter which only displays configuration 
upload logs.
The last control, "Limit to", limits the number of results. It is always on to prevent 
too large data quantity requests. For example, only 30 results are requested in the 
previous example.

Example: display the last 45 records regarding connection made on Vesta (in 
chronological order).
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Once the search criteria are set, click on "Apply" to send the request to Vesta and 
the received records will be displayed after a few seconds. If the database is not 
active in the selected Vesta or cannot meet the request since busy with other tasks 
with higher priority, or the response takes too long, a timeout is triggered to inform 
the user that the request failed. Access to data in the database has the lowest 
priority in Vesta connected device management.

If the query is correctly met, a data receipt message appears and data can be 
viewed in the specific table.

7.5 Updating the Vesta board

Board updates are made available on the installation technician portal at sidera-
terteck-it.  To receive the desired update, visit the installation technician portal using 
the Lapis function or web browser and download the corresponding package.
Once the update file is downloaded, select "Set up Vesta network" from the "Tools" 
menu. 
The board search window appears. Click "Search" to find boards in the network.

Select the Vesta to be updated from the list and click "Update". A warning message 
on operation delicacy appears: once confirmed, you can select the update file to 
send to Vesta.
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Once the file is selected, the Vesta update procedure begins. At the end of the 
procedure (this usually lasts several minutes), the Vesta board will automatically 
reboot and is ready for use. After the update, the board will be displayed in the 
board list when you click "Search".
For new Vesta version updates, updating can be confirmed by clicking "Set up" 
and checking that the version number is updated to the version indicated in the 
installation technical portal download.

NOTE: Several windows may appear with update results.  This is due to the fact 
that there are several connected network interfaces on your PC.



User manual 115

NOTE: The same procedure is used to update Visus software. The only difference 
is that no installation result window appears.

IMPORTANT: 
The update procedure is delicate. Board power outage during this phase could 
compromise correct board operations or prevent further use: we suggest you 
carefully check board connections to the power mains to ensure power is 
guaranteed. Do not attempt to manually reboot the board.
We also suggest you make sure that the network connection is always up during 
updates: do not detach the network cable from the board and do not turn off the 
router or connected network switch.
If the process fails and the board is damaged, contact technical support.

7.6 Visus and Tosca updates

Updating Visus is similar to updating Vesta. Open the "Vesta Network 
Configuration" window (“Tools” menu → “Set up Vesta network”). As with the Vesta 
update, the board search window appears. Flag the "Show Visus panels" box at the 
bottom and start the search. 

When the Visus panels in the network appear, select the one to be updated. At 
this point, the software can be updated ("Update") or a new "local project" can be 
loaded to use the touch screen directly connected to the Una bus ("Send Default 
Configuration"). 

The software update procedure is identical to the one described for the Vesta 
board. 

The "local project" update occurs in the same way: select the ".una" project file in 
which the boards are linked to the "Local" system. This file will be sent to Visus and 
used to control boards.
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7.7 Changing icons on Tosca and Visus devices

Flag the "Show Visus panels" option at the lower left and click "Search" to display a 
list of Vesta boards and running Visus and Tosca modules. To start, select a row for 
a Visus module and click "Edit icon theme".

A list of themes available in the selected Visus and the currently used theme appear. 
At least one row for the default theme will be listed along with any other loaded 
themes.
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A new theme can be created by selecting "New theme" which appears when you 
right-click the default theme row. This displays a dialogue window (shown below) 
where you can enter the name for the new theme.
The new theme is created as a copy of the default theme and can be used to create 
a custom theme. Each element in the theme generally includes two icons, associated 
with the elements two on/off statuses, which can be edited using the text menu that 
appears by right-clicking the icon, as shown below.
The dialogue window shown below will appear where you can select the new icon to 
associate with an element status.

In addition to creating themes for element classes and renaming a created theme, 
you can also add icons associated with certain elements.  To do this, right-click the 
created theme and select "Add custom element" from the text menu (shown below).
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The shown dialogue window opens where you can enter the name of the element 
and the icons associated with on/off status.

After adding the icons, click OK to add the theme to the specified element. This way, 
the selected element, for example Light point_10, will be illustrated in the map with 
the selected icon instead of the light point category icon.
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NOTE: the name of the element whose icons you want to change must be the one 
specified in system design.
You can also import new themes by clicking "Import".  A dialogue window will appear 
where you can select a theme (in .vth, "Visus Theme" format) to be loaded.
Please note that you must reboot Visus to apply changes.

7.8 Other utilities

7.8.1 Element search 

The Lapis "Tools" menu includes a function called "Element Search" that lets you 
search for any element in Lapis.

As shown in the illustration, open the dialogue window from the abovementioned 
menu and enter the name in the self-completing text box to start the search. Click 
"Search".  If the element is found in the project, its location will be displayed and the 
element will appear selected in the panel.  Otherwise a dialogue window will warn 
you that the element was not found.

7.8.2 Renaming the system

The Lapis "Tools" menu includes a function that lets you rename systems linked 
to each board in the "Project System" list with a system selected from the "Known 
system" list.
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To use this function, click "Tools">"Rename System" and the dialogue window shown 
above will guide you through the operation.

7.8.3 Programming all boards connected to Vesta

Once the project is sent to Vesta, all Una boards can be programmed using a single 
operations in the "Una Board Programming" window.
To open the window, select "Program all boards" from the Tools menu.

All boards are presented in a list where you can flag the boards you want to program. 
The type, serial number and firmware version are indicated for each board.

Click "Start programming".  Boards will be programmed one at a time.
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While programming, a progress bar appears under the corresponding board, 
representing the maximum amount of time available for programming, counting down 
from 100%: if the value reaches 0, programming is considered failed.

Depending on the type of board, the progress bar can start from 100% 1 to 3 times 
before the board is considered programmed.
In fact, various programs (timers, dawn/dusk, load cut-off, etc.) are sent to some 
boards separately.
An icon that indicates programming status is displayed to the right of each board.

No operation in progress

Updating the program

Board update successfully completed

Board update completed with an error
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7.8.4 UNA protocol statistics

To display Vesta serial bus statistics, select "Una protocol statistics" from the "Tools" 
menu.

A window will appear with the System serial lines indicated by the "combo" menu at 
the top. Statistics are divided by channel and board type and include messages per 
second, timeouts and transmission errors for each board connected to the bus (or 
buses). Click "Update" to refresh statistics for the selected system.



User manual 123

7.9 Sidera Web management from Lapis

Lapis includes a window where you can manage projects on the Sidera web portal. 
To activate the service, select "Manage projects in Sidera” from the "Tools" menu.  
A window appears similar to the one shown below.

The list of installations, meaning projects tied to a specific site created by the installer, 
is shown in the first page.

7.9.1 Creating a new installation

To create a new installation, click "New installation". At this point, the dialogue 
window shown below will open and you can enter the data required to create a new 
installation.

Enter the necessary data (note how the "Description" field is optional).  The dialogue 
window shown below lists operation results and the list of installations is newly 
retrieved by Sidera.
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When finished, the window appears as follows.

7.9.2 Selecting an installation

As shown, when a specific installation is selected, the "Project management" button 
is enabled and you can open the project management page that displays the list of 
projects for a specific installation.

7.9.3 Project management

As shown in the illustration, this page lets you run several operations for project 
management. Click "New" to create a new project. 



User manual 125

When this button is clicked, a window appears where you can enter the project name, 
installer's e-mail address and a description, optional, of the project.
When a new project is created, it is initialised with the data in the current Lapis 
project, if open.

Click "Download" to download a project from the Sidera portal. When finished, the 
system will ask the user where the project should be saved and if the project should 
be opened in Lapis.
If the user answers yes, the project open in Lapis will be closed and the downloaded 
project will be opened.

Click "Upload" to upload the project opened in Lapis on the project in Sidera. 
Information on wiring is sent with project data.
Please be careful and remember that this operation overwrites the project previously 
found on the portal, losing previous project data.

Click "Activate/Deactivate" to manage the open project. Please note that only one 
project may be running at a time for each installation.
This button text changes according to the selected project status from "Activated" to 
"Deactivated".

Lastly, a project can be deleted by selecting it from the list and clicking "Delete".

All of these operations may take several seconds to complete, downloading all data 
from the portal.
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7.9.4 Manual management

Lapis includes an automatic manual management mechanism that lets you download 
a manual from the Sidera portal or install one from the Lapis installation CD/DVD. 
To activate the service, select "Check updates" from the Lapis "Tools" menu. The 
window shown below lets you run these operations. 

In fact, you can view the list of all available manuals by clicking "Update" or search 
for a manual in the CD/DVD by clicking "Check CD/DVD". Both options populate the 
list of manuals with available manuals.  Select one of the manuals from the list, as 
shown below.  The "Install" button is enabled and you can install the selected manual 
by clicking on this button. 

Installation saves the selected manual in the user's Una/manuals/lang_code folder 
under the name LapisUserManual where lang_code is written as language_country., 
so, for instance, Italian is written as it_IT. Each installation deletes any previously 
installed versions.
To open a manual, select "Open manual" from the Lapis "Help" menu.
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8 Map editor

Lapis includes a simple and fast map creation tool.
To open the map editor, select "Create new map" from the Lapis "Edit" menu. A 
window like the one shown below will open where you can create a new map.

The tool lets you draw a map and add:
• doors
• windows
• quotas
• areas that let you add texture inside the map.
To start drawing walls, click on the wall icon in the toolbar. At this point, left click on 
the drawing area to add a wall. 
Click and drag the cursor to draw the wall. An adjacent wall can be added by left-
clicking again. 
To stop drawing, right click or click the wall icon in the toolbar again.
After adding walls, you can create a corner by nearing the ends of the walls. 
Walls can only be connected at their ends and this function is only enabled when 
drawing a wall.
As shown below, to add doors and windows, simply drag them from the list on the left 
and drop them in the drawing area. 
When these objects near a wall, they automatically become part of the wall and, 
when in contact with the wall, they will follow the same profile movements unless the 
cursor is moved too far away.
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Wall, door and window objects have properties that can be edited using the menu 
that appears when you right-click the object and select "Properties". This opens 
dialogue windows similar to those shown below. The illustration on the left shows 
wall properties while the one on the right shows door properties.
Window properties are not listed since they are the same as door properties.

After adding doors and windows you can add textures by selecting the icon in the 
toolbar. In this mode, move the cursor over the map an a red circle will show the 
points where this object can be automatically positioned.
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Similar to that described for area objects, quotas can be added by left-clicking three 
times. The first click lets you enter the starting point, the second the end point and the 
last lets you set the height of this quota.

As with areas, when drawing a quota, a red circle will appear when the cursor nears a 
wall, door, window or corner. Release the mouse button to automatically position the 
quota. The following illustration shows the procedure described above.
Text objects can also be added. To do this, select the icon in the toolbar to open the 
dialogue window, shown below, that describes the steps to be taken. 

In "Add text" mode, click on any point in the area. Enter the text to be added in this 
point in the dialogue window shown below.
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As with other objects, text properties can be edited by right-click the text and selecting 
"Properties" from the menu. The dialogue window that lets you edit text properties is 
shown below.

You can delete added objects by clicking "Cancel" on the keyboard or by clicking 
"Cancel" in the object menu.

The map plotter lets you change the zoom factor and provides an undo/redo function 
when objects are added, moved or deleted.
As shown below, you can change grid pitch from the "Edit">"Preferences" menu in an 
interval from two to five and link a different scale factor to the map.
When finished, close the plotter window and the created map will be automatically 
added to the Lapis "Map panel".  As shown below, you can reopen the map editor 
using the button on the right or the test menu that appears when you right-click the 
map.

This illustration also shows how you can add light points, switches and, in general, all 
components found in the Lapis catalogue to the created map. 
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9 Common eva programming procedures

The following chapter describes the most common EVA and EVA POWER board 
programming procedures.

9.1 Lighting

This paragraph describes the most common lighting settings. 
Import the "Light", "Halogen light" or similar objects and relevant switches to control 
previously imported elements.

Each light must be linked to a relay.  Thus, if the HELPER mode is enabled, peripherals 
will be directly connected to the first available relays. 
Otherwise, enable LINKER mode and link relays to the light icons. Follow the same 
steps to link switches to inputs.

Using LINKER mode, link each switch to one or more "Light" objects. Default 
programming for this type of link is "Jog". 
However, timed programs (see section 7.1.1) and a series of general controls (see 
section 7.2.3) can be set.

EVA implements a series of timers tied to the days of the week and time that can be 
linked to "Jog" programming.  Main timers are listed below:
•	 on/off at a set time;
•	 on at a set time without manual input control;
•	 on/off at dawn/dusk;
•	 on/off at dawn/dusk without manual input control;
•	 enable input from dawn/dusk to dusk/dawn.
For further information on timers, see section 6.3.4.

9.1.1 Timed functions 

EVA implements a series of timed functions.  Main functions are listed below:
•	 timed with reset (2);
•	 timed with restart (3);
•	 timed with denied restart (4);
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•	 delayed (5);
•	 closet (6).

Please note that the numeric reference associated with the "Output supported 
programs and functions" in section 5.2.3 is indicated in parentheses.  For further 
information on the behaviour and implementation of these programs, please see 
section 5.2.3.

Timers tied to days of the week and time like "enable input from dawn/dusk to dusk/
dawn" can be associated with these functions.

9.1.2 General controls

Via Lapis, Eva can globally control and interact with all lights using the "All on" and 
"All off" functions. To implement this function, link the switch input to be used and all 
linked relays to the light to be controlled. Set the required function.

Here too, timers tied to the days of the week and time like "turn on a function at a set 
time" or "turn on a function at dawn/dusk" can be associated.

9.1.3 Sequenced lighting

An additional function applicable to light management is programming a certain 
number of lights in sequence.

Link an input for each relay associated with the lights to be put in sequence. 
Use an additional input to control this subset, linking all inputs associated through 
relays to the lights to be put in sequence. 
The software will automatically set the input function to the "Sequenced lighting" 
input. The time between one light turning on and the next is set by "Lights in sequence 
time" while the wait time for the shutdown procedure is set by "Lights in sequence 
delay", both found in the Eva board properties window "General Options - Timers" 
folder.
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Lastly, the default off order is the same as the on order unless the "Reversed lights 
in sequence" option is enabled in the Eva board properties window "General Options 
- General Options" folder.

This architecture lets the user manage single lights without using the entire sequence.  
To do this, link a switch to the input that controls the light in question and set the "Jog" 
function.

This program can also be associated with a series of timers tied to the days of the 
week and time.  Main functions are listed below: 
•	 "start a function at a set time";
•	 "start a function at dawn/dusk";
•	 "enable a function from dawn/dusk to dusk/dawn".

9.2 Blind management

Blinds can be managed on various levels: with direct controls and with or without 
general timers.

Import "Blind", "Awning" or "Motorised window" objects using the relevant controls.  
We suggest you use a "Dual control (up/down)" input device.
Each object must be linked to two relays.  Thus, if the HELPER mode is enabled, 
peripherals will be directly connected to the first available relays.  Otherwise, enable 
LINKER mode and link relays to the imported icons. In the latter case, the function 
the relay manages will be requested: up or down.

In LINKER mode, link the various imported buttons to the relevant motorised devices 
setting the "Blind up" or "Blind down" function and relevant up/down time associated 
with the "Time" parameter in the associated input properties. 
Please note how the links to be made for each pair of elements are two or four 
according to programming (normal pressure only or normal and prolonged pressure).

Before proceeding with the following steps, check that the interlock is correctly set 
to prevent damages generated by improper control use. The interlock associated 
with each input corresponds to the input that runs the opposite function in blind 
management. 
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Once the base control is set, a series of advanced functions can be set like centralised 
and/or timed controls.  These procedures are described in the following sections.

9.2.1 Entering a general control

The "General blind" function lets you manage blind closing or opening (or similar 
devices) using a single button.
To implement it, simply introduce a "Dual control (up/down)" and, if HELPER mode is 
disabled, link it to two Eva board inputs. 
The "General blind" function works from input to input. Thus connect the first general 
key input to all inputs with the "Blind up" function to be controlled. 
LINKER mode will automatically set the "General blind" function. Perform the 
operation again linking the remaining input to the inputs with "Blind down" function. 

To increase customisation potential, the "General lighted blind" function is provided 
to lift or lower all connected devices for "t" time associated with the "Time" variable in 
the function in question set in the control device properties. 
Please note that time is global for all blinds in this case.

The Eva board also provides a "Staggered blind start" function that avoids high peak 
currents if different elements are controlled. 
The option can be enabled in the board properties window "General options - General 
options" menu.

Please note that the use of a "Dual control (up/down)" is not restricting. 
In fact, through prolonged pressure, a "Generic control" can be used associating, 
for example, "general blind up"  with normal pressure and "general blind down" with 
prolonged pressure.

9.2.2 Using sensors

Eva supports various sensors that can be linked to window treatment and awning 
functions like wind, rain and twilight sensors. 

Once sensors are imported and linked to available inputs, link the associated input to 
the input that runs the function in question. 
For example, for rain sensors, connect the input linked to the sensor with the control 
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input that lowers blinds; vice versa, for awnings, the sensor will be linked to the input 
associated with the awning up function.

Please note that the "Wind sensor" also requires the activation limit to be set by 
setting the number of impulses in proportion to wind speed in the specific "Wind 
sensor impulse" box in the associated input properties window.

The twilight sensor, unlike the previous sensors, directly effects the concerned output, 
acting as a switch.  Thus connect the associated input to the sensor with the relay 
that controls, for example, awning opening. For further information on the twilight 
sensor, see point 24 in the "Output supported programs and functions" described in 
section 5.2.3.

9.2.3 Using timers

As introduced in section 6.3.4, functions set in the previous paragraphs can be timed 
by selecting the input in question and setting the type, days and time (if necessary) 
to be run. The introduced parameters are found in the input device properties timer 
folder.  Timers available for this type of application are:
•	 start a function at a set time;
•	 start a function at dawn;
•	 start a function at dusk;

9.3 Video surveillance

To manage a video surveillance system in "Cyclic (video camera)" mode based on 
analogue video cameras, simply import the required number of video cameras. 

Each video camera must be linked to a relay.  Thus, if the HELPER mode is enabled, 
peripherals will be directly connected to the first available relays. 
Otherwise, enable LINKER mode and link relays to the video camera icon. 

Associate each relay linked to a video camera to an input using LINKER mode.  Lapis 
will automatically set the cyclic video camera function.
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Video signal length for each video camera is set by the "Cyclic Video Camera" 
parameter in the Eva board properties "General Options - Timers" folder.
If you prefer a different length for each video camera, select "Use single output times 
for the sequence" in the Eva board "General options - General options" and set time 
using the "Time" parameter in the input properties associated with the video camera.
Once the board is programmed, the cyclic function will enable all relays controlled by 
"Cyclic Video Camera" inputs in ascending relay number order and for the set time 
(global or single).
Sensor signal enabling order can be set by connecting the input associated with the 
video camera in question to a switch or bell.
In this case, regardless of the "Use single output times for sequence" option, the 
signal will be kept for a time equal to the value entered in the "Time" box in the input 
properties associated with the video camera.

Note: refer to the Eva board manual for physical video camera connections to the 
board.

9.4 Panel templates

The "Panel Template" folder in the Lapis software installation DVD provides two 
panels with their relevant wiring diagrams ("Panel wiring 1/2.pdf”) that implement 
most of the programs described in this chapter.

Panel 1 includes a system based on Eva board with:
•	 1 Outdoor light (linked to relay 1) to be placed near the gate.
•	 2 Blinds (linked to relays 2, 3, 4, 5) to be placed in the day and night areas;
•	 1 Awning (linked to relays 6,7) to be placed in the living room area;
•	 3 Video cameras (linked to relays 8, 9, 10) to be placed near the gate and 2 other 

points in the garden;

controlled by:
•	 a dual control for each blind or awning;
•	 a rain sensor to control blind and awning closing;
•	 a wind sensor to control awning closing with a number of impulses over 3;
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•	 a dual control with "General blind" function on normal pressure and "General 
lighted blind" on prolonged pressure;

•	 a button that simulates the bell and enables the video camera placed near the 
gate an the relevant light for 30 [s] ("Timed with reset" function).

It also includes:
•	 blind up/down time: 30[s];
•	 awning up/down time: 15[s];
•	 cyclic video camera: 10[s];
•	 blind reverse delay: 5[s];
•	 prolonged pressure: 5[s];
•	 general lighted blind time: 15[s]
•	 from Monday to Friday, enable all blind openings at dawn (setting the dawn/dusk 

time for Padua) and closing at 10 pm.
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Panel 2 includes:
•	 6 Lights (linked in pairs to relays 1, 2, 3) to be placed in the garden walkway;
•	 1 Light (linked to relay 4) to be place in front of the garage;
•	 1 Light (linked to relay 5) to be placed in the garden (day area side);
•	 1 Light (linked to relays 6, 7, 8, 9) to be placed in the bedroom, hallway, bathroom 

and living room;
•	 1 Light (linked to relay 10) for the closet.
controlled by:
•	 a generic control for walkway lights with "Sequenced lighting" function with a 5 [s] 

on delay for the various light pairs to start the off procedure;
•	 a generic control to manage the light in front of the garage with "Start function at 

a set time" function;
•	 a generic control to manage the garden light with "jog" function in normal 

pressure and timed from Monday to Sunday with the "enable input from dusk to 
dawn" option;

•	 a generic control to manage the bedroom light with "jog" function in normal 
pressure and "timed with restart" function (t = 10[s]) associated with prolonged 
pressure;

•	 a generic control to manage the bathroom light;
•	 a generic control to manage the hallway light with "jog" function in normal 

pressure and "timed with restart" function (t = 20[s]) associated with prolonged 
pressure;

•	 a generic control to manage the living room light with "jog" function in normal 
pressure and "All off" function associated with prolonged pressure;

•	 an input directly linked to relay 11 with "Closet" function.
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